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保証 2

Tektronix では、 本製品において、 出荷の日から 1 年間、 材料およびその仕上がり について欠陥がないこ と を保
証し ます。 この保証期間中に製品に欠陥がある こ とが判明し た場合、 Tektronix では、 当社の裁量に基づき、 部
品および作業の費用を請求せずに当該欠陥製品を修理するか、 あるいは当該欠陥製品の交換品を提供し ます。
保証時に Tektronix が使用する部品、 モジュール、 および交換する製品は、 新しいパフ ォーマンスに適応する
ために、 新品の場合、 または再生品の場合もあ り ます。 交換し たすべての部品、 モジュール、 および製品は
Tektronix で所有されます。

本保証に基づきサービスをお受けいただ く ため、 お客様には、 本保証期間の満了前に当該欠陥を当社に通知
し ていただき、 サービス実施のための適切な措置を講じ ていただきます。 お客様には、 当該欠陥製品を梱包
し ていただき、 送料前払いにて当社指定のサービス ・ セン ターに送付し ていただきます。 本製品がお客様に
返送される場合において、 返送先が当該サービス ・ セン ターの設置されている国内の場所である と きは、 当
社は、 返送費用を負担し ます。 しかし、 他の場所に返送される製品については、 すべての送料、 関税、 税金
その他の費用をお客様に負担し ていただきます。

本保証は、 不適切な使用または不適切も し く は不十分な保守および取り扱いによ り生じ たいかなる欠陥、 故
障または損傷にも適用されません。 当社は、 以下の事項については、 本保証に基づきサービスを提供する義
務を負いません。 a） 当社担当者以外の者による本製品のイ ンス ト ール、 修理またはサービスの試行から生じ
た損傷に対する修理。 b） 不適切な使用または互換性のない機器への接続から生じ た損傷に対する修理。 c）
当社製ではないサプ ラ イ用品の使用によ り生じ た損傷または機能不全に対する修理。 d） 本製品が改造または
他の製品と統合された場合において、 改造または統合の影響によ り当該本製品のサービスの時間または難度
が増加し た と きの当該本製品に対するサービス。

この保証は、 明示的または黙示的な他のあらゆる保証の代わり に、 製品に関し て Tektronix がお客様に対し て
提供する ものです。 当社およびそのベンダは、 商品性または特定目的に対する適合性についての一切の黙示
保証を否認し ます。 欠陥製品を修理または交換する当社の責任は、 本保証の不履行についてお客様に提供さ
れる唯一の排他的な法的救済と な り ます。 間接損害、 特別損害、 付随的損害または派生損害については、 当
社およびそのベンダは、 損害の実現性を事前に通知されていたか否かに拘わらず、 一切の責任を負いません。
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安全にご使用いただ く ために
安全にご使用いただ く ために
人体への損傷を避け、 本製品やこ れに接続さ れる製品への損傷を防ぐために、 次の安全性に関する
注意事項をよ く 読んでく ださ い。 安全にご使用いただく ため、 本製品の指示に従ってく ださ い。

保守点検の手順を実行できるのは、 資格のあるサービス担当者のみです。

火災や人体への損傷を避けるには

適切な電源コー ドの使用 . 本製品用に添付および指定さ れ、 使用国で認定さ れた電源コード のみ
を使用してく ださ い。

適切な接地 . 本製品は、 電源コード の接地線を通して接地さ れます。 感電を避けるため、 接地線を
アースにつなげる必要があり ます。 本製品の入出力端子に接続する前に、 製品が正し く 接地さ れて
いるこ と を確認してく ださ い。

端子の定格について . 火災や感電の危険を避けるため、 本製品のすべての定格と マーキングに
従ってく ださ い。 本製品の接続を行う 前に、 定格の詳細について製品マニュアルを参照してく ださ
い。 コモン端子を含むすべての端子に最大定格を超える電圧を加えないでく ださ い。

電源切断 . 電源コード の取り 外しによって主電源が切り 離さ れます。

カバーの取り外し . カバーやパネルを外した状態で本製品を動作さ せないでく ださ い。

故障と思われる場合 . 故障と 思われる場合、 資格のあるサービス担当者に検査しても らってく だ
さ い。

機器が濡れた状態では使用し ないで く だ さ い . 

爆発性のあるガスがある場所では使用し ないで く だ さい . 

製品の表面は常にきれいにし て く だ さ い . 

適切な通気 . 適切な通気が得られるよ う に、 製品のインスト ールについての詳細は、 本マニュアル
のインスト レーショ ンのページを参照してく ださ い。
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安全にご使用いただ く ために
本マニュ アルで使用する用語

本マニュアルでは次の用語を使用します。

本製品に関する記号および用語

本製品では次の用語を使用します。

■ DANGER: ただちに人体や生命に危険をおよぼす可能性があるこ とを示します。

■ WARNING: 人体や生命に危険をおよぼす可能性があるこ とを示します。

■ CAUTION: 本製品を含む周辺機器に損傷を与える可能性がある こ とを示します。

本製品では、 次の記号を使用します。

警告 ：人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意 ：本製品やその他の接続機器に損害を与える状態や行為を示します。

注意
マニュ アル参照

警告
高電圧

保護接地
( アース ) 端子 l

アース端子 シ ャーシ
グラ ン ド

ス タ ンバイ
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環境に関する考慮事項
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環境に関する考慮事項
このセクシ ョ ンでは、 製品の環境に対する影響について説明します。

製品の廃棄方法

機器またはコンポーネン ト を リサイ クルする際には、 次のガイ ド ラ インを遵守して ください。

機器のリサイ クル . 本機器を生産する際には、 天然資源が使用されています。 本機器には、 製品を
廃棄する際に適切に処理されなかった場合に、 環境または人体に有害となる物質が含まれています。
有害物質の放出を防ぎ、 天然資源の使用を減らすため、 機材の大部分を再利用またはリサイ クルで
きるよ うに本製品を正し く リサイ クルして ください。

左に示すシンボルは、この製品が WEEE (Waste Electrical and 
Electronic Equipment) Directive 2002/96/EC （廃棄電気 ・ 電子
機器に関する指令） に基づく EU の諸要件に準拠しているこ
とを示しています。 リサイ クル方法については、 Tektronix 
のウェブ ・ サイ ト （www.tektronix.com） のサポート / サー
ビスの項目を参照して ください。

水銀に関する通知 . この製品に使用されている LCD バッ ク ラ イ ト ・ ランプには、 水銀が含まれて
います。 廃棄にあたっては、 環境への配慮が必要です。 廃棄およびリサイ クルに関しては、 お住ま
いの地域の関係官庁等にお尋ねください。

有害物質に関する規制

この製品は Monitoring and Control （監視および制御） 装置に分類され、 2002/95/EC RoHS Directive 
（電気 ・ 電子機器含有特定危険物質使用制限指令） の範囲外です。 この製品には、 鉛、 カド ミ ウム、
水銀、 および六価ク ロムが含まれています。
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はじめに
はじめに
本マニュアルでは、 AWG7000 シ リーズの機器の設置と操作方法について説明します。 基本的な操
作方法や概念について主に記述されます。 詳細については、 機器のオンライン ・ ヘルプを参照して
ください。 本マニュアルは、 次の機器を対象と しています。

■ AWG7101

■ AWG7102

■ AWG7051

■ AWG7052

主な機能

AWG7000 シ リーズ の主な機能は次のとおりです。

■ Windows XP Professional オペレーティング ・ システム

■ 最大 64,800,000 メモ リ長 ( オプシ ョ ン 01)

■ 広帯域アナログ出力 ( オプシ ョ ン 02)

■ インターリーブおよび広帯域アナログ出力 ( オプシ ョ ン 06)、 AWG7102 型のみ

■ 大型 10.4 インチ (264.2 mm) 高分解能 XGA カラー ・ ディ スプレイ

■ オンライン ・ ヘルプを内蔵した直感的なグラフ ィカル ・ ユーザ ・ インタフェース

■ 80 GB ハード ・ ディ ス ク ・ ド ラ イブ

■ CD-RW/DVD

■ USB 2.0 インタフェースをサポート

■ LAN (1000/100/10 Base-T)

■ タ ッチ ・ ス ク リーン ・ インタフェース

型 　 名 AWG7101 AWG7102 AWG7051 AWG7052

最大サンプ リ ング ・
レー ト

10 GS/s 10 GS/s (20 GS/s、
イ ン ター リ ーブ )

5 GS/s

D/A 分解能 8 ビ ッ ト 、 または 10 ビ ッ ト （切替可能）

メ モ リ長 32,400,000 または 64,800,000 （オプシ ョ ン 01 付の場合）

アナログ出力 1 2 1 2

最大振幅および
アナログ帯域

2 Vp-p, 750 MHz （Direct Output: オフ）
1 Vp-p, 3.5 GHz （Direct Output: オン）
1 Vp-p, 5.8 GHz （オプシ ョ ン 02 または 06 モデル）

マーカ出力 2 4 (2/ チャ ンネル ) 2 4 (2/ チャ ンネル )
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はじめに
マニュ アル

関連情報はさまざまな媒体で利用できます。 本製品に関する各種情報の参照先は以下のとおりです。

本マニュ アルの表記規則

このマニュアルでは次のアイコンを使用しています。

参照する項目 使用する ド キュ メ ン ト

インス ト レーシ ョ ン、 操作概要 機器の操作とユーザ ・ インタフェース ・ コン ト ロールに関す
る一般的な内容については、 「ク イ ッ ク ・ スター ト ・ ユー
ザ ・ マニュアル」 を参照して ください。

操作方法の詳細とユーザ ・ インタ
フェースに関するヘルプ

前面パネル ・ コン ト ロールやスク リーン ・ インタフェースに
関する詳しい説明は、 Help メニューからユーザ ・ オンラ イ
ン ・ ヘルプにアクセスします。 オンライン ・ ヘルプには、 機
器の諸機能の使用方法が記載されています。 (10 ページ 「オ
ンラ イン ・ ヘルプへのアクセス」 参照 )

プログラマ ・ ヘルプ Help メニューからプログラマ ・ オンラ イン ・ ヘルプを選択
します。 プログラマ ・ ヘルプで リモート ・ コマンドのシン
タ ッ クスを簡単に参照できます。

性能の確認と仕様 性能の確認と仕様については、 製品のドキュ メン ト CD に収
録されている Technical Reference マニュアルの PDF ファ イ
ルを使用して ください。

前面パネル
電源

電源の接続 ネ ッ ト
ワーク

PS2 SVGA USB
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機器のイ ンス ト ール
機器のイ ンス ト ール
機器を開梱し、 スタンダード ・ アクセサ リ と して記載されているすべての付属品が含まれている こ
とを確認して ください。 推奨アクセサ リ と機器のオプシ ョ ンについては、 オンラ イン ・ ヘルプに記
載されています。 最新の情報については、 Tektronix のホームページ （www.tektronix.com） を参照
して ください。

ス タ ンダー ド ・ ア クセサリ

ア クセサリ Tektronix 部品番号

AWG7000 シ リーズ 任意波形ゼネレータ  
ク イ ッ ク ・ スタート ・ ユーザ ・ マニュアル

英語 （オプシ ョ ン L0） 071-1851-xx
日本語 （オプシ ョ ン L5） 071-1852-xx

オペレーティング ・ システム  リ ス ト ア DVD 020-2762-xx
プロダク ト ・ ソフ ト ウェア CD 020-2763-xx
ドキュ メ ン ト CD 063-3994-xx
ユーザ ・ オンラ イン ・ ヘルプ ( プロダク ト ・ ソフ ト ウェアの一部 ) –––
プログラマ ・ オンラ イン ・ ヘルプ ( プロダク ト ・ ソフ ト ウェアの一部 ) –––
キーボード (Windows 互換 ) 119-7083-00
マウス (Windows 互換 ) 119-7054-00
スタイ ラス ・ ペン、 2 本 119-6107-00
DC 出力用リードセッ ト 012-1697-00
前面パネル ・ カバー 200-4963-00
アクセサ リ ・ ポーチ 016-1441-01
50 Ω SMA ターミネーシ ョ ン、 オス、 DC ～ 18 GHz、 3 個 / チャンネル 015-1022-01
電源コード

北米 ( オプシ ョ ン A0) 161-0104-00
欧州 ( オプシ ョ ン A1) 161-0104-06
英国 ( オプシ ョ ン A2) 161-0104-07
オース ト ラ リ ア ( オプシ ョ ン A3) 161-0104-14
スイス ( オプシ ョ ン A5) 161-0167-00
日本 ( オプシ ョ ン A6) 161-A005-00
中国 ( オプシ ョ ン A10) 161-0306-00
インド ( オプシ ョ ン A11) 161-0324-00
電源コードまたは AC アダプタなし ( オプシ ョ ン A99) –––
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機器のイ ンス ト ール
動作の要件

電源の要件

ク リ ーニング

任意波形ゼネレータの使用環境に応じて機器の検査を行って ください。 機器表面のク リーニングは
次の手順を実行します。

1. 乾いた柔らかい布で機器の表面に付着した塵を落と します。 前面パネルのディ スプレイを傷つけ
ないよ うに注意して ください

2. 水で湿らせた柔らかい布を使用して機器の汚れを落と します。 75% イ ソプロピル ・ アルコール

水溶剤を使用する と汚れがよ く落ちます。

1. 次の設置条件を確認し、 機器を
カート またはベンチに設置しま
す。

■ 上部 : 20 mm (0.8 in)

■ 左側および右側 : 150 mm 
(5.9 in)

■ 底部 : 20 mm (0.8 in)

■ 後部 : 75 mm (3 in)

2. 動作させる前に、 周囲温度が
+10 °C ～ 40 °C (+50 °F ～
+104 °F) であるこ とを確認して
ください。

注意 ：排気が確実に行われるよ うに、 機器の両側に障害物を置かないでください。
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Open Save
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OnOnOnOnOnOn
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Event
Input

Trigger
Input

Force
Event

Force
Trigger
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CAUTION
TURN OFF OUTPUTS
BEFORE CHANGING

CABLES OR
 POWERING DUT.  

Arbitrary Waveform GeneratorAWG 7XXX

!

 5V RMS 

!

O f fO f f

OnOnOnOnOnOn

ChCh 2ChCh 2Ch 2

ChCh 1ChCh 1Ch 1

RunRunRunRunRunRun

GND

Channel 1 Channel 2

Analog Analog Analog Analog Mkr 1 Mkr 1 Mkr 2 Mkr 2 Mkr 1 Mkr 2 Mkr 2Analog Analog Mkr 1

10 GS/s

Interleave

DO NOT APPLY EXTERNAL SIGNAL
!

AWG 7102 10 GS/sArbitrary Waveform Generator

465 mm
( ハン ドル含む )

245 mm

電源電圧と周波数 100 VAC ～ 240 VAC、 47 Hz ～ 63 Hz

消費電力 450 W 未満

警告 ：以下の手順を実行する前に、 機器の電源をオフにして、 電源コードを取り外します。

注意 ：研磨剤や化学洗浄剤は使用しないでください。 本機器の表面を傷つけるおそれがあ り ます。
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機器のイ ンス ト ール
機器の電源をオンにする

機器の電源をオフにする

1. 機器の後部パネルに AC 電源コー
ドを接続します。

2. 前面パネルのパワー ・ ボタンを押
して、 機器の電源をオンにしま
す。

1. 前面パネルのパワー ・ ボタンを押
して、 機器をシャ ッ ト ダウンしま
す。

パワー ・ ボタンを押してから電源
が切れるまで約 30 秒かかり ます。

2. 機器の電源を完全にオフにするに
は、 シャ ッ ト ダウン実行後、 電源
コードを取り外します。

!
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機器のイ ンス ト ール
Windows イ ン タ フ ェ ース ・ ガイ ド ラ イ ン

本機器は、 Microsoft 社の Windows インタフェースを使用していますので、 Excel、 WordPad や
Paint などの Windows ベースのアプ リ ケーシ ョ ンにアクセスできます。

Windows インタフェースへのアクセスは可能ですが、 機器の操作に悪影響を及ぼすおそれがあ り ま
すので、 オペレーティング ・ システムを変更するこ とは避けて ください。 以下のガイ ド ラ インに
従って ください。

■ Control Panel の内容を変更する と きは十分に注意して ください。専門知識のない場合は、Control 
Panel の内容を変更しないでください。

■ システム ・ フォン ト を削除した り、 変更した り しないでください。 本機器の表示に影響を及ぼす
おそれがあ り ます。

■ Background、 Appearance、 Effects、 Settings など、 システムの表示プロパティ を変更しないでく
ださい。 機器の操作性やタ ッチ ・ ス ク リーンに影響を及ぼすおそれがあ り ます。

■ Windows フォルダや Program Files\Tektronix\AWG\System フォルダの内容を変更しないでくださ
い。

■ BIOS の設定を変更しないでください。 BIOS 設定を変更する と、 機器全体の動作に影響を及ぼし
ます。

Windows インタフェースの動作によ り機器に障害が発生している と思われる場合は、 Tektronix の
サポート ・ センターまでご連絡ください。
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機器のイ ンス ト ール
ネ ッ ト ワークへの接続

本機器をネッ ト ワークに接続して、 印刷、 ファ イル共有、 インターネッ ト ・ アクセスなどの機能を
利用できます。 ネッ ト ワークに対して機器を設定するには、 ネッ ト ワーク管理者に問い合わせ、 標
準の Windows ユーティ リ テ ィ を使用して ください。

GPIB、 LAN の設定には、 System メニューの GPIB/LAN Configuration ダイアログ ・ ボッ クスを使
用します。 68 ページを参照して ください。

リ モー ト PC を利用し た機器のコ ン ト ロール

Windows の Remote Desktop 機能を利用するこ とで、 LAN を経由して、 お使いの PC を利用して任
意波形ゼネレータをコン ト ロールできます。 PC のスク リーンが本機器よ り も大きい場合、 キーボー
ト とマウスを利用してよ り効率的な編集作業を行えます。 また、 PC にインス トールされているサー
ドパーティ ・ ソフ ト ウェアを使って波形を作成し、 それをネッ ト ワーク経由でインポートするこ と
もできます。
AWG7000 シ リーズ ク イ ッ ク ・ ス ター ト ・ ユーザ ・ マニュアル 5



機器のイ ンス ト ール
オフ ラ イ ン ・ モー ド

オフライン ・ モード とは、 本機器のアプ リ ケーシ ョ ンをお使いの PC 上で実行させる機能です。 ア
プ リ ケーシ ョ ンを PC にインス トールして ください。 機器の本体ハード ウェアは不要です。 機器の
設定ファ イルの作成および編集が可能です。 PC で作成したファ イルをのちほど本機器で使用できま
す。

1. 機器に付属している Product SW 
CD を使用して AWG7000 シ リー
ズ ・ アプ リ ケーシ ョ ンを PC にイ
ンス トールします。

2. オフライン ・ モードを使用する前
に、 機器のコンフ ィグレーシ ョ ン
を設定する必要があ り ます。

Windows の Start メニューから、
All Programs > Tektronix > 
AWG > AWG Config Utility を選
択して Configuration Utility ダイ
アログ ・ ボッ クスを表示します。

3. ご使用の機器のタイプを選択しま
す。

4. ご使用の機器のオプシ ョ ン設定を
指定します。

5. OK をク リ ッ ク します。

Start メニューから機器のアプ リ
ケーシ ョ ンを起動する と、Config-
uration Utility の設定内容が反映
されます。

1
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機器のイ ンス ト ール
機器の検査

機器の機能を確認するために、 2 種類の診断ルーチンが用意されています。

■ パワーオン ・ セルフテス ト  – 本機器は、 電源投入時にセルフテス ト を実行します。

■ System メニューからの診断実行 – 以下の手順を実行します。

1. メニュー ・ バーから System メ
ニューの Diagnostics... を選択し
ます。

Diagnostics ダイアログ ・ ボッ ク
スが表示されます。

2. Loop がチェッ ク されていないこ
とを確認します。

Loop がチェッ ク されている と、
手動で停止されるまで診断が繰り
返されます。

3. Select All をク リ ッ クする と、 全
項目がチェ ッ ク されます。

全項目の診断をま とめて実行する
こ と も、 選択した項目のみの診断
を実行するこ と もできます。

4. Execute をク リ ッ クする と、 診断
が実行されます。

エラーが報告されないこ とを確認
します。 エラーが報告された場合
は、 Tektronix のサービスまでご
連絡ください。

1

2

3

4
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機器のイ ンス ト ール
自己校正

自己校正は、 内部診断ルーチンによ りアナログ ・ レベル、 マーカ ・ レベル等の電気的特性をチェ ッ
ク し、 必要に応じ内部校正定数を調整します。

注 ：本手順を実行する前に、 機器の電源を入れ 20 分間オンのままにしておきます。

1. 前面パネルのRunボタンがオフの
状態であるこ とを確認して、 信号
が出力されていないこ とを確認し
ます。

2. 校正を実行するには、 メニュー ・
バーから System > Calibration...
を選択します。

Calibration ダイアログ ・ ボッ クス
が表示されます。

3. Execute を選択します。

4. 出力用のコネク タに接続されてい
るケーブルを取り外すこ とを要求
するダイアログ ・ ボッ クスが表示
されます。

5. ケーブルを取り外し、 OK を押し
ます。 校正が終了するまで待ちま
す。

エラーが報告されないこ とを確認
します。 エラーが報告された場合
は、 Tektronix のサービスまでご
連絡ください。

注 ：自己校正は有効な温度条件下でないと正し く行われません。 動作の要件については、 2 ページを

参照して ください。

注 ：アナログおよびマーカの出力レベルの確度を維持するために、 １ ヶ月に１度自己校正を実行し

て ください。 実行しない場合、 アナログおよびマーカ出力に関して保証されている性能レベルを満

たさないこ とがあ り ます。

RunRunRunRunRunRun 1
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機器のイ ンス ト ール
機器の損傷防止

過熱保護機能

本機器は過熱検出機能を持ち、 機器の内部温度がモニタ されます。 過熱状態を検出する と、 次の動
作が実行されます。

■ 機器内部温度がしきい値を超える と警告メ ッセージが表示されます。

■ 機器の温度がさ らに上昇する と、 本機器は自動的にシャ ッ ト ダウンします。

警告メ ッセージが表示されたら、 次の条件をチェ ッ ク して ください。 動作の要件については、
2 ページを参照して ください。

■ 機器が所定の温度範囲で使用されている。

■ 所定の設置条件 （ク リ アランス） を満足している。

■ 機器のファンが正し く動作している。

出力コ ネク タ

本機器の前面パネルには、 信号出力用のコネク タ と入力用のコネク タが用意されています。 信号出
力用コネク タに外部からの信号を加えないでください。

出力用コネク タに外部電圧を加えないで く だ さ い。
機器を損傷する恐れがあ り ます。

注意 ：信号出力コネク タにケーブルを接続または取り外す場合は、 必ず任意波形ゼネレータの信号

出力をオフにして ください。 信号出力がオンの状態で外部機器 (DUT) を接続する と、 本機器や

DUT に損傷を与えるこ とがあ り ます。
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機器のイ ンス ト ール
オン ラ イ ン ・ ヘルプへのア クセス

任意波形ゼネレータでは、 2 種類のオンラ イン ・ ヘルプが用意されています。

■ ユーザ ・ オンラ イン ・ ヘルプ – 機器のすべての機能に関する詳細情報を参照できます。

■ プログラマ ・ オンラ イン ・ ヘルプ – リ モー ト ・ コマン ドに関するプログラ ミ ング情報もオンラ イ
ン ・ ヘルプの形式で提供されます。

ヒ ント

■ ユーザ ・ オンラ イン ・ ヘルプで表示される言語と して英語または日本語を選択できます。 デフォ
ル トでは、 英語が選択されています。 言語を変更するには、 System メニューから Preferences...
を選択します。 69 ページを参照して ください。

■ プログラマ ・ オンラ イン ・ ヘルプは英語表示のみです。

ヘルプ ・ システムにアクセスするに
は、 メニュー ・ バーから Help を選
択します。

1. ユーザ ・ オンラ イン ・ ヘルプにア
クセスするには、 Help Topic... を
選択します。

2. 現在の操作ウ ィンド ウに関する状
況に応じたヘルプ （コンテキス ト
依存ヘルプ） を利用するには、
Help on Window... を選択するか、
または F1 キーを押します。

3. プログラマ ・ オンラ イン ・ ヘルプ
にアクセスするには、 Help on 
Remote Commands... を選択しま
す。

4. 仕様とパフォーマンス検証手順を
記載した PDF マニュアルにアク
セスするには Specifications... を
選択します。

5. ほとんどのダイアログ ・ ボッ クス
には、 Help ボタンがついていま
す。 ボタンをク リ ッ クする と、 現
在表示されているダイアログ ・
ボッ クスに関するヘルプを表示し
ます。

注 ：日本語オンライン ・ ヘルプを初めて開く と、 Language pack をインス トールするためのダイアロ

グ ・ ボッ クスが表示されます。 Install をク リ ッ ク して Japanese Language pack をインス トールして

ください。

3
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前面パネル
前面パネル
次の図は、 AWG7102 型オプシ ョ ン 06 型の前面パネルを示しています。

前面パネル・ コ ネク タ

コネク タ 説 　 明

1. Interleave Output このコネク タは AWG7102 オプシ ョ ン 06 にのみ付属し、 10 GS/s ～
20 GS/s のアナログ信号を出力します。
コネク タ ・ タ イプ : SMA

2. Analog Output アナログ信号を出力します。
コネク タ ・ タ イプ : SMA

3. Marker Output マーカ信号を出力します。
コネク タ ・ タ イプ : SMA

4. Trigger Input 外部ト リガ信号を入力できます。
コネク タ ・ タ イプ : BNC

5. Event Input イベン ト信号を入力できます。
コネク タ ・ タ イプ : BNC

6. USB 2 つの USB デバイスを接続できます。

7. DC Output 4 チャンネルの DC 電圧を出力します。
コネク タ ・ タ イプ : 2.54 mm 2 x 4 ピン ・ ヘッダ ( メ ス )

72 3 6541

注意 ：信号出力コネク タにケーブルを接続または取り外す場合は、 必ず任意波形ゼネレータの信号

出力をオフにして ください。 信号出力がオンの状態で外部機器 (DUT) を接続する と、 本機器や

DUT に損傷を与えるこ とがあ り ます。
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後部パネル
後部パネル

後部パネル・ コ ネク タ

コネク タ 説 　 明

1. External Clock Input オシレータ入力用コネク タ
コネク タ ・ タ イプ : SMA

2. Reference Clock Input 外部リ ファレンス ・ ク ロ ッ ク入力用コネク タ
コネク タ ・ タ イプ : BNC

3. 10 MHz Reference Output 10MHz リ ファレンス ・ ク ロ ッ ク信号出力コネク タ
コネク タ ・ タ イプ : BNC

4. GPIB GPIB コネク タを使用して機器と GPIB コン ト ローラを接続します。

5. LAN RJ-45 コネク タを使用して機器をネッ ト ワークに接続します。

6. Parallel Port パラレル ・ ポート (Centronics) は、 プ リ ンタや他のデバイスを接続し
ます。

7. USB USB デバイスを接続します。

8. Video ビデオ ・ ポートは、 モニタの接続に使用します。

9. COM1 COM1 シ リ アル ・ ポートは、 他の機器をシ リ アル ・ ポート経由で接
続する と きに使用します。

10. PS-2 PS-2 キーボードやマウスを接続するのに使用します。

11. HDD 取り外し可能な HDD です。

12. このコネク タはサポート されていません。

!
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コ ン ト ロール ・ パネル
コ ン ト ロール ・ パネル

Run. Run ボタンは信号発生動作の開始 / 停止をコン ト ロールします。 信号が発生している と きは
LED が点灯します。 実際に出力コネク タから信号を出力させるには、 前面パネルの All Outputs 
On/Off ボタン、 または Channel Output On ボタンを押して出力をイネーブルにする必要があ り ます。

Touch Screen Off. タ ッチスク リーン機能がオンの状態のと き、 指先やスタイ ラス ・ ペン等を使用し
てスク リーン ・ インタフェースをコン ト ロールできます。 タ ッチ ・ ス ク リーンがオフのと き、 LED
が点灯します。

File Open/Save. Open または Save ボタンが押される と、 対応するダイアログ ・ ボッ クスが表示さ
れ、 設定ファ イル (*.AWG) をロード または保存ができます。

Factory Default. このボタンを押すと指定されたデフォル ト設定が呼び出されます。 デフォルト設定
については、 32 ページを参照して ください。

Timing – Sampling Rate. このボタンを押すと Settings ウ ィ ン ド ウで Timing ページのサンプ リ ング ・
レー トのパラ メータが選択されます。 サンプ リ ング ・ レー トは各チャンネルに共通です。 Settings
ウ ィ ン ド ウについては、 26 ページを参照して ください。

Channel Select.  チャンネル選択ボタンは、 操作の対象となるチャンネルを選択するのに使用しま
す。 前面パネルのチャンネル選択ボタンが押される と、 Settings ウ ィ ン ド ウの対応するチャンネル
のページがアクテ ィブにな り ます。

Channel Output On. チャンネル出力のオン / オフを切り替えます。 出力がオンの状態のと き LED が
点灯します。

Run ボタ ン

Channel Output On
ボタ ン

Channel Select
ボタ ン

汎用 ノ ブ

桁選択キー

注意 ：前面パネルの信号出力コネク タに外部機器 (DUT) を接続する と きは、 必ず本機器の信号出力

をオフにして ください。

本機器の信号出力がオンの状態では、 外部機器の電源オン / オフを行わないでください
AWG7000 シ リーズ ク イ ッ ク ・ ス ター ト ・ ユーザ ・ マニュアル 13



コ ン ト ロール ・ パネル
All Outputs On/Off. ひとつ以上の出力がオンのと きにこのボタンを押すと、 すべての出力がオフにな
り ます。 すべての出力がオフのと きにこのボタンを押すと、 すべての出力がオンにな り ます。

Amplitude. このボタンを押すと Settings ウ ィ ン ド ウで該当するチャンネルの Amplitude のパラ メー
タが選択されます。 振幅は各チャンネルで個別に設定できます。

Offset. このボタンを押すと Settings ウ ィ ン ド ウで該当するチャンネルの Offset のパラ メータが選択
されます。 オフセッ トは各チャンネルで個別に設定できます。

Marker 1 および Marker 2 – High/Low. このボタンを押すと Settings ウ ィ ン ド ウで該当するチャンネ
ルの Marker High または Marker Low のパラ メータが選択されます。 Marker High と Marker Low は
各チャンネルで個別に設定できます。

Force Trigger. このボタンを押すと、 内部ト リ ガ信号を出力します。

Force Event. このボタンを押すと、 内部イベン ト信号を出力します。

汎用 ノ ブ . このノブは、 設定値を増減させた り、 ポップアップ ・ メニュー、 プルダウン ・ メニュー、
またはダイアログ ・ ボッ クスでアイテムを選択するのに使用されます。 ノブを時計回りに回すと値
が増加し、 反時計回りに回すと値が減少します。

桁選択キー . 桁選択矢印キーは、 編集フ ィールドで数字を変更する と きの桁移動に使用します。 数
字を変更するにはノブを使用します。

数値入力キー . 数値入力後に単位用接頭語キー （T/p、 G/n、 M/μ、 k/m） を押すと、 Enter キーを押
すこ とな く値を確定できます。

周波数の場合は T （テラ）、 G （ギガ）、 M （メガ）、 k （キロ） と解釈されます。 時間の場合は p （ピ
コ）、 n （ナノ）、 μ （マイ ク ロ）、 m （ ミ リ ） と解釈されます。
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コ ン ト ロール ・ パネル
前面パネル ・ コ ン ト ロールのロ ッ ク / ロ ッ ク解除

任意波形ゼネレータの前面パネルは、 GPIB や Ethernet で リモート操作されている間にロ ッ ク され
る場合があ り ます。 前面パネルがロ ッ ク されている と電源スイ ッチを除くすべてのキーやボタンは
使用できな くな り ます。 マウスやキーボード も使用できません。 ただし、 前面パネルがロ ッ ク状態
でも Windows の操作は可能です。

前面パネル ・ コン ト ロールのロ ッ クを解除するには、 リモート ・ コマンドを使用するか、 または前
面パネルの Cancel ボタンを 2 回続けて押します。 アプ リ ケーシ ョ ンを終了する と ロ ッ ク状態は解除
されます。 再びアプ リ ケーシ ョ ンを起動した場合、 前面パネルはロ ッ ク解除されています。

タ ッ チ ・ ス ク リ ーン ・ イ ン タ フ ェ ース

任意波形ゼネレータでは、 メニュー選択のために 2 つの方法が用意されています。

■ 前面パネル ・ コン ト ロール、 キーボード、 およびマウス

■ 前面パネル ・ コン ト ロールと タ ッチ ・ ス ク リーン ・ インタフェース

1. 前面パネルのTouch Screen ボタン
を押すこ とによ り、 タ ッチ ・ ス ク
リーン機能のオンとオフを切り替
えられます。

タ ッチ ・ ス ク リーンをオフにする
には、 Touch Screen ボタンを押し
ます。 オフの状態で LED が点灯
します。 この状態でもスク リーン
のメニューにはマウスまたはキー
ボードでアクセスできます。

注 ：下記のいずれかに該当する場合は、 タ ッチ ・ ス ク リーンの調整が必要です。

■ オペレーティング ・ システムを再インス トールする場合

■ ハード ・ ディ スク ・ ド ラ イブを交換する場合

■ タ ッチ ・ ス ク リーンが正し く応答しな くなった場合

Windows デスク ト ップ上のシ ョー ト カッ トからタ ッチ ・ ス ク リーン ・ プログラムを起動して調整を
実行して ください。

1
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コ ン ト ロール ・ パネル
コ ン ト ロール設定を変更する

機器を設定する と きに、 振幅レベルやオフセッ ト などの数値パラ メータを設定する必要があ り ます。
スク リーン ・ ウ ィ ン ド ウでこれらのパラ メータを設定するには、 タ ッチするかク リ ッ ク してそのパ
ラ メータを選択します。 いったん選択する と、 そのパラ メータに対して汎用ノブが有効にな り ます。

コン ト ロール設定を変更する と きには、 汎用ノブを使用できますが、 以下に述べる方法によっても
設定を変更するこ とができます。

ヒ ント

■ ポップアップ ・ キーボード とキーパッ ドは、 それぞれソフ ト ・ キーボード と ソフ ト ・ キーパッ ド
と呼ぶこ とがあ り ます。

1. いくつかのパラ メータには、 増加
/ 減少ボタンが用意されています。
これらのボタンはスピン ・ ボタン
と も呼ばれます。 ク リ ッ クする と
次の有効な値に変更できます。

数字の桁を移動するには、 桁選択
キー （14 ページ参照） を使用し
ます。

2. いくつかのパラ メータでは、 ポッ
プアップ ・ キーパッ ド またはキー
ボードが用意されており、 新しい
値を入力できます。

キーパッ ド （またはキーボード）
アイコンをク リ ッ クする と、 キー
パッ ド （またはキーボード） が表
示されます。

1

2
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コ ン ト ロール ・ パネル
Run State コ ン ト ロールと出力のオン / オフ

任意波形ゼネレータで信号発生の開始および停止をコン ト ロールするには、 以下のステップを実行
します。

ヒ ント

■ 各チャンネルの出力のオン / オフは個別にコン ト ロールできます。

■ 各チャンネルのアナログ出力とマーカ出力は同時にオン / オフされます。

1. 前面パネルRunボタンを使用して
信号発生の開始および停止をコン
ト ロールします。

信号発生のオン / オフ切り替えを
Run State （動作状態） コン ト ロー
ルと呼びます。

信号が発生している状態で LED
インジケータが点灯します。

2. 出力コネク タから実際に信号を出
力するには、 前面パネルの All 
Outputs On/Off ボタンまたは
Channel Output On ボタンを押
して、 信号出力をオンにする必要
があ り ます。

3. あるいは、 Settings ウ ィ ンド ウの
Ch n (Channel) ページを使用して
信号出力をオンにするこ と もでき
ます。 Settings ウ ィ ンド ウについ
ては、 26 ページを参照して くだ
さい。

1
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イ ン タ フ ェース とデ ィ スプレ イ
イ ン タ フ ェース とデ ィ スプレ イ
スク リーン ・ インタフェースを使用して機器のすべての機能にアクセスできます。 このユーザ ・ イ
ンタフェースは Windows オペレーティ ング ・ システム上で構築されています。

ス ク リ ーン ・ イ ン タ フ ェ ース

メ ニュー ・ バー . メニュー ・ バーから機器のすべての機能にアクセスできます。 メニュー項目を選
択する と、 対応するコン ト ロール ・ ウ ィ ン ド ウ （ダイアログ ・ ボッ クス） が表示されるか、 または
選択したメニュー項目がただちに実行されます。

ステータ ス ・ バー . ステータス ・ バーはメニュー ・ バーの下に位置し、 サンプ リ ング ・ レー ト 、 動
作モード状態、 出力ステータスなどの機器情報を表示します。

Waveform List ウ ィ ン ド ウ . Waveform List にはユーザ定義波形とあらかじめ定義された波形のリ ス
トがあ り ます。

Sequence ウ ィ ン ド ウ . このウ ィ ン ド ウは、 主にシーケンスに関する情報を表示します。

Waveform ウ ィ ン ド ウ . このウ ィ ン ド ウには、 Waveform List または Sequence Window で選択され
た波形が表示されます。

Settings ウ ィ ン ド ウ . このウ ィ ン ド ウは、 パラ メータ設定へのク イ ッ ク ・ アクセス と して用意され
ています。

ウ ィ ン ド ウ ・ タ グ . タグをク リ ッ クする と、 対応するウ ィ ンド ウの表示 / 非表示を切り替えます。

リ モー ト ・ コ マン ド ・ バー . 現在の機器操作に対応する リモート ・ コマンドが表示されます。

メ ニュー ・ バー

Sequence
ウ ィ ン ド ウ

Waveform List
ウ ィ ン ド ウ

リ モー ト ・
コ マン ド ・ バー

ステータ ス ・ バー

Waveform
ウ ィ ン ド ウ

Settings
ウ ィ ン ド ウ

ウ ィ ン ド ウ ・
タ グ
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イ ン タ フ ェース とデ ィ スプレ イ
任意波形ゼネレータ操作の基本ステ ッ プ

機器の電源投入後、 メニュー ・ バーまたはコン ト ロール ・ ウ ィ ン ド ウを使用して波形の作成、 編集
を行います。 メニューおよびコン ト ロール ・ ウ ィ ン ド ウへのアクセスについては、 20 ページを参照
して ください。 波形を出力するには次の手順を実行します。

ヒ ント

■ 任意波形ゼネレータには、 4 つの動作モードが用意されていますが、 シーケンス ・ モード以外の
状態を非シーケンス ・ モード (Non-sequence mode) と呼ぶこ とがあ り ます。

■ 非シーケンス ・ モードでは、 各チャンネルで 1 つの出力波形を選択できます。

1. 新しい波形を作成するには、 Edit 
> Standard Waveform... を選択し
ます。 作成した波形は、 Wave-
form List ウ ィ ン ド ウに表示され
ます。

2. 既存の波形を使用するには、 File 
> Open File... で設定ファ イルを
開き、 Waveform List ウ ィ ン ド ウ
に登録してある波形を選択しま
す。

3. 動作モードを確認します。 Set-
tings ウ ィ ンド ウの Run Mode
ページで、 希望する動作モードが
選択されているこ とを確認しま
す。

4. 信号を発生させるには、 前面パネ
ルの Run ボタン、 またはステー
タス ・ バーの Run ボタンを押し
ます。

5. 次のいずれかを使用して、 チャン
ネルの出力をオンにします。

■ 前面パネルの Channel Output 
On ボタンまたは All Outputs 
On/Off ボタン

■ Settingsウ ィ ン ド ウChページの
Output On ボタン

1
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イ ン タ フ ェース とデ ィ スプレ イ
メ ニューおよびコ ン ト ロール ・ ウ ィ ン ド ウへのア クセス

各メニューのコマンドやコン ト ロール ・ ウ ィ ン ド ウにアクセスするために、 さまざまな手段が用意
されています。

1. メニュー ・ バーから Settings をク
リ ッ ク して、 コマンドを選択しま
す。

選択した項目が Settings ウ ィ ンド
ウでアクティブにな り ます。

2. 設定メニューへのシ ョート カッ ト
と して、 Settings ウ ィ ン ド ウを使
用できます。

Settings ウ ィ ン ド ウで Ch 1 や
Timing のタブをク リ ッ クする と、
対応するページが表示されます。
機器の各種設定を選択するのに使
用します。

3. 前面パネルから、 サンプ リ ング ・
レート 、 振幅レベル、 オフセッ
ト ・ レベル、 およびマーカ ・ レベ
ルの各パラ メータ設定にすばやく
アクセスできます。

これらのボタンの 1 つを押すと
Settings ウ ィ ン ド ウの対応するパ
ラ メータが選択されます。

4. マウスの右ク リ ッ クで関連する メ
ニュー項目に簡単にアクセスでき
ます。

たとえば、 Waveform List ウ ィ ン
ド ウ上で右ク リ ッ クする と、 関連
する Edit メニューが表示されま
す。

1
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イ ン タ フ ェース とデ ィ スプレ イ
コ ン ト ロール ・ ウ ィ ン ド ウの表示切替

任意波形ゼネレータのスク リーンには、 デフォル トで 4 つのコン ト ロール ・ ウ ィ ン ド ウが表示され
ます。 ウ ィ ン ド ウ ・ タグを使用して、 各ウ ィ ンド ウの表示 / 非表示をすばやく切り替える こ とがで
きます。

1. 動作モードがシーケンスの場合、
デフォルトでは、 4 つのウ ィ ンド
ウすべてが表示されます。

2. Waveform List タグをク リ ッ ク し
ます。

3. Waveform List ウ ィ ンド ウが非表
示とな り ます。

1
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2
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イ ン タ フ ェース とデ ィ スプレ イ
ステータ ス ・ バー

ステータス ・ バーは 2 つの機能を持ちます。 サンプ リ ング ・ レー ト 、 Run ステート 、 動作モードな
どの機器の現在のステータスを表示します。 さ らに、 Force Trigger、 Force Event、 All Outputs 
On/Off、 および Run ボタンが配置されています。 これらのボタンをク リ ッ クする と、 それぞれのア
クシ ョ ンが実行されます。

1. Sampling Rate サンプリ ング ・ レートが表示されます。

2. Run Status 機器の動作状態 （Running または Stopped） が表示されます。

3. Run Mode 現在の動作モード （29 ページ参照） が表示されます。

4. Force Trigger ボタン 前面パネルの Force Trigger ボタンと同じ機能です。

5. Force Event ボタン 前面パネルの Force Event ボタンと同じ機能です。

6. All Outputs On/Off ボタン 前面パネルの All Outputs On/Off ボタンと同じ機能です。

7. Run ボタン 前面パネルの Run ボタンと同じ機能です。

71 2 3 4 5 6

機器のステータ スを表示し ます
これらのボタ ンを ク リ ッ クする と
ア ク シ ョ ンが実行されます
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イ ン タ フ ェース とデ ィ スプレ イ
Waveform List ウ ィ ン ド ウ

Waveform List ウ ィ ン ド ウには、 機器の設定 (*.AWG) ファ イルに保存されている波形が リ ス ト され
ます。 定義済み波形とユーザ定義波形の 2 つのリ ス トが用意されています。

ヒ ント

■ Waveform List ウ ィ ン ド ウで右ク リ ッ クする と、 ポップアップ ・ メニューが表示されます。 波形の
削除、 コピーやペース ト などのメニューが表示されます。

■ ユーザ定義波形を作成する と きに、 定義済み波形と同じ名前をつける こ とはできません。 定義済
み波形とは別の名前をつけて ください。

1. 定義済み波形を選択するには、
Predefined タブをク リ ッ ク しま
す。

2. 定義済み波形の名前の左側にはア
スタ リ ス ク ・ サイン (*) がつきま
す。

注 : 定義済み波形を編集、 削除、 名
称変更するこ とはできません。

3. ユーザ定義波形を選択するには、
Waveform List で User Defined タ
ブをク リ ッ ク します。

4. 波形の名称、 波形長、 または日付
順に波形リ ス ト をソートできま
す。

5. Waveform List ウ ィ ンド ウでは、
波形長は数字 3 桁で表示されま
す。

6. 正確な波形長を知りたいと きは、
波形を選択して右ク リ ッ ク し、
ポップアップ ・ メニューから
Waveform Properties... を選択して
表示されるダイアログ ・ ボッ クス
で確認できます。

2
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イ ン タ フ ェース とデ ィ スプレ イ
Sequence ウ ィ ン ド ウ

動作モードで Sequence が指定される と、 このウ ィ ン ド ウにはシーケンス設定の情報が表示されま
す。 動作モードについては、 29 ページを参照して ください。

ヒ ント

■ Sequence ウ ィ ン ド ウで選択された波形が Waveform ウ ィ ン ド ウに表示されます。 選択されたセル
は背景色が変わり ます。

■ 既存の波形をシーケンスに適用するために、 次の方法が用意されています。

■ Waveform List ウ ィ ン ド ウの波形を Sequence ウ ィ ン ド ウのセルにド ラ ッグする

■ Sequence ウ ィ ン ド ウでセルを指定してから、 Edit メニューの Set Waveform... または Insert 
Waveform... コマンドを使用する

■ 動作モードで、 Continuous、 Triggered、 または Gated が選択される と、 Sequence ウ ィ ン ド ウはス
ク リーンから隠れます。

■ Sequence ウ ィ ン ド ウでは、 下記のアイコンが使用されます。

1. Sequence ウ ィ ンド ウの表示例で
す。 表示フォーマッ トはサムネイ
ルです。

サムネイル表示のと き、 マウスを
セルに持っていく と、 そのセルに
表示されている波形の名称と波形
長がツールチップ （小さいポップ
アップ ・ ウ ィ ン ド ウ） で表示され
ます。

2. テーブル表示の例です。

表示アイ コ ン 説 　 明

Wait Trigger

Repeat ( この例では Repeat count が 26 に設定されています )

Repeat (Infinite、 無限に繰り返します )

Event Jump ( この例では Jump ターゲッ トがインデッ クス番号 26 に
設定されています )
Go To ( この例では Go To のターゲッ トが 26 に設定されています )

1

2
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イ ン タ フ ェース とデ ィ スプレ イ
Waveform ウ ィ ン ド ウ

Sequence ウ ィ ン ド ウで選択されたエレ メン ト または Settings ウ ィ ン ド ウの Ch n ページで選択され
た波形がこのウ ィ ンド ウに表示されます。

ヒ ント

■ Sequence ウ ィ ン ド ウ と Waveform ウ ィ ン ド ウの表示フォーマッ トは、 View メニュー > Display 
Properties ダイアログ ・ ボッ クスで変更できます。 または、 ウ ィ ン ド ウ内で右ク リ ッ ク しても
Display Properties ダイアログ ・ ボッ クスにアクセスできます。

■ アナログ ・ データのみ、 マーカ ・ データのみ、 またはアナログとマーカの両方を選択して
Waveform ウ ィ ン ド ウに表示できます。

■ Waveform ウ ィ ン ド ウの波形データをク リ ア （初期化） するには、Edit メニュー > Clear を使用し
ます。

■ 垂直軸と水平軸の単位は、 Display Properties ダイアログ ・ ボッ クスを使用して次のとおり選択
できます。

■ 垂直軸 – Voltage または Normalized Value

■ 水平軸 – Points または Time

1. これは Graphic 表示の例です。
Ch1 と Ch2 のアナログ ・ データ
とマーカ ・ データが表示されてい
ます。

2. 2 つのカーソルを使用して、 編集
領域を指定できます。

3. Table 表示の例です。
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イ ン タ フ ェース とデ ィ スプレ イ
Settings ウ ィ ン ド ウ

Settings ウ ィ ン ド ウを使用して、 Level (Ch1、 Ch2)、 Timing、 Run Mode、 Trigger、 Event、 DC Out-
put などのパラ メータにすばやくアクセスできます。 振幅、 オフセッ ト 、 マーカ ・ ハイ / ロー、 サン
プ リ ング ・ レー ト など頻繁に使用されるパラ メータについては、 前面パネルのボタンから も選択可
能です。 メニューへのアクセス方法については 20 ページを参照して ください。 

Channel (Ch n) ページ

ヒ ント

■ 各チャンネルはそれぞれ独立して出力のオン / オフ設定が可能です。あるチャンネルの出力がオン
に設定される と、 アナログ出力とマーカ出力の両方がオンにな り ます。

■ Direct Output をオンにする と、 フ ィルタ とオフセッ トの設定は無効にな り ます。 また振幅の設定
範囲が変わり ます。

■ オプシ ョ ン 02 型 （拡張アナログ出力帯域） およびオプシ ョ ン 06 型 （インターリーブ） の製品では
フ ィルタ とオフセッ トの設定はあ り ません。 また、 Direct Output の設定もあ り ません。

■ Waveform Rotation については、 62 ページを参照して ください。

1. チャンネルの出力をオンにするに
は、 Output On ボタンをク リ ッ ク
します。

2. 振幅、 オフセッ ト 、 フ ィルタ、
マーカの各パラ メータを設定でき
ます。

3. DAC 分解能で 10 ビッ ト を選択す
る と、 マーカ出力は無効になり ま
す。

4. Direct Outputのオン /オフを選択し
ます。

5. シーケンス ・ モード以外のと き
は、 Output Waveform フ ィールド
で、 出力波形を選択できます。
フォルダのアイコンをク リ ッ クす
る と、 Waveform List ダイアロ
グ ・ ボッ クスが表示されます。

6. シーケンス ・ モード以外のと き、
アナログ出力信号の位相 (Phase)
または遅延 (Delay) を設定できま
す。

1
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イ ン タ フ ェース とデ ィ スプレ イ
Timing ページ

ヒ ント

■ サンプリ ング ・ レートは、 ク ロ ッ ク ・ ソースが Internal で、 かつ次のいずれかの条件を満たすと
きに設定できます。

■ リ ファレンス ・ ソースが Internal のと き

■ リ ファレンス ・ ソースが External で、 外部リ ファレンス ・ タ イプが Fixed のと き

■ 任意波形ゼネレータは、 Fixed 外部リ ファレンス ・ ソース と して、 10 MHz、 20 MHz、 または
100 MHz の信号を受け入れます。

■ ク ロ ッ ク ・ ソースが Internal、 リ ファレンス ・ ソースが External、 外部リ ファレンス ・ タ イプが
Variable のと き、 Multiplier Rate を設定できます。

■ Timing ページの各パラ メータの設定レンジについては、 オンラ イン ・ ヘルプを参照して くださ
い。

1. Sampling Rate を設定します。

2. シーケンス ・ モード以外のと き
Repetition Rate を設定できます。

3. ク ロ ッ ク・ソース (Internal または
External) を選択します。

■ External のと きは、 外部オシ
レータからのク ロ ッ ク信号が
使用されます。

■ Internal のと きは、 ク ロ ッ ク信
号は内部で生成されます。

4. ク ロ ッ ク ・ ソースが External のと
き、 Divider Rate を設定できま
す。

5. リ ファレンス・ソース (Internal ま
たは External) を選択します。

リ ファレンス ・ ソースはク ロ ッ
ク ・ ソースが Internal のと きの
み有効です。

6. 外部リ ファレンス ・ タ イプ
(Variable または Fixed) を選択し
ます。

このパラ メータは、 ク ロ ッ ク ・
ソースが Internal で リ ファレン
ス ・ ソースが External のと きの
み有効です。

1
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イ ン タ フ ェース とデ ィ スプレ イ
イ ンタ ーリ ーブ

AWG7102 オプシ ョ ン 06 型はインターリーブ機能付です。 2 つのチャンネルをインターリーブして
よ り高いサンプル ・ レー ト と長い波形長を実現します。

ヒ ント

■ 出力がオンの状態でインターリーブのオン / オフを切り替える と、 出力はオフにな り ます。

■ 以下の表に、 インターリーブによって拡大されるサンプル ・ レー ト と波形長の関係がま とめられ
ています。 

1. インターリーブをオンにするに
は、 Settings ウ ィ ン ド ウの
Ch1 ページを選択し、 Interleave
ボッ クスをチェ ッ ク します。

2. インターリーブをオンにする と、
Ch2 ページが灰色になり、 Ch2 の
パラ メータは選択できな くな り ま
す。

3. インターリーブがオンの状態のと
き、 Zeroing のオン / オフを選択
できます。

Zeroing をオンにする と、 帯域は
増大しますが、 振幅の設定レンジ
が変わり ます。 デフォルトでは、
Zeroing オフです。

機種名およびオプシ ョ ン イ ン ター リ ーブ サンプル ・ レー ト 波形長

AWG7102 オプシ ョ ン 01、 オプ
シ ョ ン 06

オン 10 GS/s ～ 20 GS/s 1 ～ 129,600,000 ポイ ン ト

オフ 10 MS/s ～ 10 GS/s 1 ～ 64,800,000 ポイ ン ト

AWG7102 オプシ ョ ン 06 オン 10 GS/s ～ 20 GS/s 1 ～ 64,800,000 ポイ ン ト

オフ 10 MS/s ～ 10 GS/s 1 ～ 32,400,000 ポイ ン ト

AWG7101 オプシ ョ ン 01 使用不可 10 MS/s ～ 10 GS/s 1 ～ 64,800,000 ポイ ン ト

AWG7101 　 使用不可 10 MS/s ～ 10 GS/s 1 ～ 32,400,000 ポイ ン ト

AWG7051/AWG7052 オプシ ョ ン 01 使用不可 10 MS/s ～ 5 GS/s 1 ～ 64,800,000 ポイ ン ト

AWG7051/AWG7052 　 使用不可 10 MS/s ～ 5 GS/s 1 ～ 32,400,000 ポイ ン ト

12
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イ ン タ フ ェース とデ ィ スプレ イ
Run Mode ページ

ヒ ント

■ 任意波形ゼネレータは以下の動作モードをサポート します。

■ 連続 (Continuous)
連続した波形が出力されます。

■ ト リ ガ (Triggered)
本機器が ト リガ信号を受信したと きに 1 つの波形を出力します。 波形を出力した後は、 次の

ト リガ信号待ちの状態になり ます。

■ ゲート (Gated)
ゲート信号が有効な状態のと きのみ波形が出力されます。 ゲート信号が有効な間は連続した
波形が出力されます。

■ シーケンス (Sequence)
シーケンスで定義された順序に従って複数の波形が出力されます。

1. 動作モードを選択します。

2. ト リ ガ ・ モード とゲート ・ モード
では、 ト リ ガ待ちの状態での出力
値を選択できます。

■ First – 出力レベルと して波形
の最初の値を指定します。

■ Last – 出力レベルと して波形
の最後の値を指定します。

1

2
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イ ン タ フ ェース とデ ィ スプレ イ
Trigger ページ

ヒ ント

■ ト リ ガのパラ メータが、 信号出力動作をコン ト ロールします。 ト リ ガのパラ メータは、 動作モー
ドが Continuous のと きは設定できません。

■ ト リ ガ ・ ソースで選択した信号のほかに、前面パネルの Force Trigger ボタンを押しても ト リ ガを
発生するこ とができます。

1. ト リ ガ ・ ソース (Internal または
External) を選択できます。 デ
フォルトは External です。

2. External を選択する と、 ト リ ガ ・
レベル、 ト リ ガ ・ スロープ、 ト リ
ガ ・ インピーダンスを設定できま
す。

■ Level – 外部ト リ ガの ト リ ガ ・
レベルを設定します。

■ Slope – 外部ト リガを使用する
と き、 立上り (Positive)、 立下
り (Negative) のどちらのエッ
ジで ト リガをかけるかを指定
します。

■ Impedance – 外部ト リガのイン
ピーダンスを指定します
（1 kΩ または 50 Ω）。

3. Internal を選択する と、 内部ト リ
ガの ト リ ガ間隔が設定できます。

1

3 2
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イ ン タ フ ェース とデ ィ スプレ イ
Event ページ

動作モードが Sequence のと き使用できます。

ヒ ント

■ イベン ト ・ ジャンプ (Event Jump) とは、 シーケンスをイベン ト信号で切り替える機能です。

■ ジャンプ・ タ イ ミ ングは、Event Jump と Force Jump の両方に適用されます。シーケンスにおける
ジャンプについては、 67 ページを参照して ください。

■ 前面パネルの Force Event ボタンを押すと内部イベン ト信号を発生できます。

DC Output ページ

1. 外部イベン ト入力のしきい値を設
定します。

2. 外部イベン ト入力の極性 (Positive
または Negative) を選択します。

■ Positive を選択する と、 パルス
の立上がりでジャンプします。

■ Negative を選択する と、 パル
スの立下りでジャンプします。

3. ジャンプ・タイ ミ ング (Async また
は Sync) を選択します。

■ Async を選択する と、 ジャン
プはただちに実行されます。

■ Sync を選択する と、 ジャンプ
は現在の波形を出力したあと
で実行されます。

4. イベン ト入力インピーダンス (1 kΩ
または 50 Ω) を設定します。

1. 任意波形ゼネレータは4つのDC出
力を持ちます。

DC 出力のレベルは個別に設定で
きます。

2. 出力状態 （オン / オフ） の切り替
えはすべての DC 出力チャンネル
に共通です。

1 2 3 4

2
1
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イ ン タ フ ェース とデ ィ スプレ イ
デフ ォル ト 設定

前面パネルの Factory Default ボタンを押すと工場出荷時設定を呼び出すこ とができます。

パワー ・ オン時の機器設定

電源投入時に呼び出される機器設定を選択できます。

1. 機器の設定を工場出荷時状態に戻
すには、 前面パネルの Factory 
Default ボタンを押します。

2. 設定が変更されている場合、 現在
の設定を保存するかど うかを確認
するダイアログ ・ ボッ クスが表示
されます。

3. File メニューから も工場出荷時設
定を呼び出すこ とができます。

1

2

3

System > Preferences... を選択して、
Preferences ダイアログ ・ ボッ クスを
表示します。 以下の中から電源投入
時の設定を選択できます。

1. Factory Default – 電源投入時に、
工場出荷時設定が呼び出されま
す。

2. Last Used File – 電源投入時に、最
後に保存または呼び出された設定
が呼び出されます。

3. User Default File – 電源投入時に、
ユーザが指定した設定ファ イルが
常に呼び出されます。

4. フォルダ ・ アイコンをク リ ッ クす
る と設定ファ イルを指定するため
のダイアログ ・ ボッ クスが表示さ
れます。

このアイコンは、 User Default 
File が選択されたと きに有効にな
り ます。

1

2
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File メ ニューを使用する
File メ ニューを使用する
機器設定の保存や呼び出し、 波形データのインポート、 エクスポート などの基本的なファ イル操作
は File メニューを使用します。 また、 最近使用した設定の呼び出しなどの Windows の標準的な操
作も File メニューで行います。

下記のメニュー ・ コマンドが File メニューに用意されています。 各メニュー ・ コマンドの詳細につ
いては、 オンラ イン ・ ヘルプを参照して ください。

ヒ ント

■ アプ リ ケーシ ョ ンを起動した状態で、 前面パネルのパワー ・ ボタン （On/Standby スイ ッチ） を押
すこ とによ り、 機器をシャ ッ ト ダウンする こ と もできます。 パワー ・ ボタンを押すと、 現在の設
定を保存するかど うかを確認するダイアログ ・ ボッ クスが表示され、 機器のシャ ッ ト ダウン ・ プ
ロセスが開始されます。

1. 工場出荷時設定を呼び出します。
32 ページ参照。

2. 機器設定をロードするためのダイ
アログ ・ ボッ クスを表示します。

3. 機器の設定を保存 （上書き） しま
す。

4. 機器の設定に名前をつけて保存し
ます。

5. 波形データをインポート します。

6. 波形データを他のアプ リ ケーシ ョ
ンで使用するためにエクスポート
できます。

7. 最近アクセスした設定ファ イルが
こ こに表示されます。

8. アプ リ ケーシ ョ ンを終了します。

9. アプ リ ケーシ ョ ンを終了し、 機器
をシャ ッ ト ダウンします。

3

8

2 1

7

6

9

4

5
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File メ ニューを使用する
機器設定を保存する

機器の設定を保存するには、 下記の手順を実行します。

ヒ ント

■ 設定を保存する と きに、 波形フォーマッ トが Integer の場合は、 設定ファ イルのサイズが小さ くな
り ます。 波形のデータ ・ フォーマッ ト （Real または Integer） についての詳細は、 オンラ イン ・
ヘルプを参照して ください。

■ Waveform、 Waveform List、 Settings の各ウ ィ ン ド ウで、 波形のフォーマッ ト を変換する と きは、
Waveform Properties ダイアログ ・ ボッ クスを使用します。 56 ページを参照して ください。

1. File > Save File を選択する と、 既
存の機器設定を更新された設定
ファ イルで上書きします。

2. 現在の設定を新しい設定ファ イル
と して保存するには、 File > 
Save File As... を選択するか、 ま
たは前面パネルの File – Save ボ
タンを押します。

3. 表示されるダイアログ ・ ボッ クス
で、 設定を保存する場所を選択し
ます。

4. ファ イル名を入力するか、 デフォ
ルトの名前を使用します。

5. Save をク リ ッ ク します。

2

1

3

4 5
34 AWG7000 シ リーズ ク イ ッ ク ・ ス ター ト ・ ユーザ ・ マニュアル



File メ ニューを使用する
機器設定を呼び出す

File メニューまたは Windows Explorer から機器設定を呼び出すこ とができます。

ヒ ント

■ 任意波形ゼネレータでは、 拡張子が .AWG のファ イルを設定ファ イルと して使用します。 Open 
File ダイアログ ・ ボッ クスでは、 デフォル トで .AWG のファ イルのみが表示されます。

■ いったん設定を呼び出すと、呼び出された設定は Save File または Save File As... が実行されるま
で保持されます。 機器のパラ メータを変更後、 Save File を選択する と、 設定ファ イルはただち
に上書きされます。

■ 設定ファ イルが呼び出される と、 DC Output を含む出力ステータスはオフにな り ます。

1. File > Open File... を選択する と、
Open File ダイアログ ・ ボッ クス
が表示されます。

前面パネルの File – Open ボタン
を押しても Open File ダイアロ
グ ・ ボッ クスが呼び出されます。

2. 設定ファ イルを選択します。

3. Open をク リ ッ ク します。

注 ：AWG5000 シ リーズおよび AWG7000 シ リーズで作成した設定ファ イルには互換性があ り ます

が、 設定ファ イル中の数値パラ メータが当該機器のサポート範囲を超えている場合は警告メ ッセー

ジが表示されます。 この場合、 範囲外のパラ メータはデフォル ト値とな り ます。

1

3

2
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File メ ニューを使用する
波形データのイ ンポー ト

データ ・ インポート機能によって本機器以外で作成された波形データを使用するこ とができます。
データをインポート して新しい波形を作成した り、 既存の波形データを置き換える こ とができます。

任意波形ゼネレータは、 次のファ イル形式をサポート します。

■ AWG5000 シ リーズまたは AWG7000 シ リーズで作成した *.AWG ファ イル

■ Tektronix AWG400、 AWG500、 AWG600、 AWG700 シ リーズ等で作成した次のファ イル形式

■ *.PAT

■ *.SEQ

■ *.WFM

■ Tektronix AFG3000 シ リーズで作成した *.TFW ファ イル

■ Tektronix DTG5000 シ リーズで作成した *.DTG ファ イル

■ Tektronix TDS/DPO シ リーズ オシロスコープで作成した波形ファ イル (*.WFM、 *.ISF)

■ テキス ト ・ ファ イル (*.txt)

ファ イル ・ インポートの詳細は、 オンラ イン ・ ヘルプを参照して ください。

1. File > Import from File...を選択す
る と、 Import from File ダイアロ
グ ・ ボッ クスが表示されます。

2. インポートする波形データの
フォーマッ ト を選択します。

3. OK をク リ ッ ク します。

ステップ 4 に示すよ う な、 File 
Import ダイアログ ・ ボッ クスが
表示されます。

1
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File メ ニューを使用する
4. インポートするファ イルを選択し
ます。

5. Operation でインポート動作を指
定します。

■ Set to
チャンネルと インデッ クス番
号を指定します。 指定した位
置にインポート した波形が割
り当てられます。

■ Insert before
インポート した波形が指定し
たセルの前に挿入されます。
動作モードがシーケンス以外
の場合、 このパラ メータは無
効にな り ます。

■ Create only
インポート した波形が Wave-
form List ウ ィ ン ド ウに表示さ
れます。

■ Overwrite
既存の波形データが上書きさ
れます。

6. Change H/W Setup を使用して、イ
ンポートする波形データにサンプ
リ ング ・ レートや振幅、 オフセッ
トの情報が含まれる場合、 その属
性を指定できます。

たとえば、 Sampling Rate を
チェッ クする と、 インポートする
データ と同じ波形が再現されるよ
うに、 サンプ リ ング ・ レートが適
切に設定されます。

7. Open をク リ ッ ク します。

インポートする波形のフォーマッ
トが、 *.AWG、 *.DTG、 *.TXT
の場合は、 それぞれに対応するダ
イアログ ・ ボッ クスが表示されま
す。

インポートする波形のフォーマッ
トが、 *.AWG、 *.DTG、 *.TXT
以外の場合は、 選択したファ イル
がインポート され、 波形名が
Waveform List ウ ィ ンド ウに リ ス
ト されます。

7

65
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File メ ニューを使用する
8. インポートするファ イル形式が
Tektronix AWG5000 シ リーズま
たは AWG7000 シ リーズの場合、
右のよ う なダイアログ ・ ボッ クス
が表示されます。

インポートする波形を選択しま
す。

9. OK をク リ ッ クする と、 波形デー
タがインポート されます。

一度に複数の波形データをイン
ポートするこ とができます。

10. インポートするファ イルが
Tektronix DTG5000 シ リーズの場
合、 右のよ う なダイアログ ・ ボッ
クスが表示されます。

11. インポートする DTG5000 シ リー
ズ ブロ ッ ク ・ データの各ビッ ト
(DTG bits) を本機器のビッ ト
(AWG bits) に割り当てます。

8

9

10
11
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File メ ニューを使用する
ヒ ント

■ 新しい波形を作成する と きは、 インポート したファ イルの名前が新規作成の波形名称とな り ま
す。

■ ファ イル ・ インポート機能を実行する と、 既存の波形のサイズはインポート されたファ イルと同
じ波形長に変更されます。

12. インポートするファ イル形式がテ
キス ト ・ ファ イルの場合、 右のよ
う なダイアログ ・ ボッ クスが表示
されます。

Format で、 ファ イル形式を指定
します。

13. Normalize で、 ノーマライズの方
法を選択します。

■ None
ノーマライズを行いません。

■ Fit to DAC Range, Preserve 
Offset
0 を基準と してスケーリ ング
されます。

■ Fit to Full DAC Range
元のデータの最小値が -1.0、
最大値が +1.0 になるよ うにス
ケーリ ングされます。

14. インポート実行時に、 同じ名称の
波形がすでに存在している場合、
右のよ う なダイアログ ・ ボッ クス
が表示されます。 波形を置き換え
る場合は、 Yes または Yes to All
を選択します。

13

12

14
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File メ ニューを使用する
波形データのエ ク スポー ト

任意波形ゼネレータは、 一つの波形データを .txt 形式のファ イルに変換してエクスポートできます。

ヒ ント

■ エクスポートする波形データのファ イル形式と して、 次の中から指定します。

■ Text (*.txt)

■ Text – Digital 8 bits (*.txt)

■ Text – Digital 10 bits (*.txt)

■ シーケンス ・ モードでは、 任意のセルを選択後、 右ク リ ッ クで表示されるポップアップ ・ メ
ニューからダイアログ ・ ボッ クスを表示できます。

1. エクスポートする波形を指定しま
す。 Waveform List ウ ィ ンド ウ上
で波形を選択します。

2. File > Export Waveform to File...
を選択する と、 ダイアログ ・ ボッ
クスが表示されます。

波形データ ・ ファ イルを保存する
場所を選択します。

3. Waveform List ウ ィ ンド ウ上で選
択した波形の名前が表示されま
す。

4. Save をク リ ッ クする と、 指定し
た波形データを .txt 形式のファ イ
ルと してエクスポートできます。

1
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Edit メ ニューを使用する
Edit メ ニューを使用する
Edit メニューを使用して、 新しい波形を作成した り、 既存の波形を編集できます。

1. Undo は、 最後のプロセスを取り
消します。

Undo は、 カーソル位置、 ズーム、
およびスク ロール機能では適用さ
れません。

2. Redo は、 最後のプロセスを繰り
返します。

3. Standard Waveform ダイアログ ・
ボッ クスを開きます。 

4. Sequence Control Parameters ダイ
アログ ・ ボッ クスを開きます。 

5. Cut または Delete ダイアログ ・
ボッ クスを開きます。

シーケンスではアクシ ョ ン ・ ボタ
ンとな り ます。

6. Delete All Waveforms は、 設定
ファ イル内のすべての波形データ
を削除します。

7. Clear は、 選択したシーケンス ・
エレ メン トのデータをク リ ア （初
期化） します。 シーケンスの残り
のデータはシフ ト しません。

Waveform ウ ィ ン ド ウでは、 選択
したチャンネルの波形データをク
リ アします。

8. Copy ダイアログ ・ ボッ クスを開
きます。

シーケンスではアクシ ョ ン ・ ボタ
ンとな り ます。

9. Paste は、 ク リ ップボードの中身
をコピーします。

10. 編集関連の各種のダイアログ ・
ボッ クスを開きます。

11. マーカ編集のサブメニューを開き
ます。

12. Waveform Properties ダイアログ ・
ボッ クスを開きます。

1

2

8

3

7

5
4

6

9

10

11

12
AWG7000 シ リーズ ク イ ッ ク ・ ス ター ト ・ ユーザ ・ マニュアル 41



Edit メ ニューを使用する
標準波形の作成

Standard Waveform ダイアログ ・ ボッ クスを使用して新しい波形を作成できます。

1. Edit > Standard Waveform... を選
択する と、 Standard Waveform ダ
イアログ ・ ボッ クスが表示されま
す。

2. Function で波形のタイプを選択し
ます。 サイン波、 三角波、 方形
波、 ランプ波、 ガウシャン ・ ノ イ
ズ、 または DC から波形を選択で
きます。

3. Timing では、 周波数、 波形長、 お
よびサイ クルの各パラ メータを設
定できます。

4. Sampling Rate で Auto、 No 
Change のいずれかを指定しま
す。

■ Auto
信号周波数に応じて適切な波
形長とサンプ リ ング ・ レート
が自動的に設定されます。

■ No Change
サンプリ ング ・ レートは変化
しません。 周波数、 波形長、
サイ クルのう ちの 2 つのパラ
メータを設定する と、 残りの
1 つは自動的に計算されます。

5. Preview に波形が表示されます。
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6. Level で、振幅 / オフセッ ト または
ハイ / ローのパラ メータを設定で
きます。

7. Option で、 振幅 / オフセッ トの設
定方法を選択します。 Option フ
レームは、 垂直軸の単位に Volt-
age を選択したと きのみ表示され
ます。

垂直軸の単位に Normalized Value
を選択する と Option フレームは
無効にな り ます。 垂直軸の単位設
定については、 59 ページを参照
して ください。

8. Operation で、 波形の作成方法や
位置指定を行います。

■ Set to
チャンネルと インデッ クス番
号を指定して、 新規に波形を
作成します。 指定した位置に
作成した波形がアサインされ
ます。

■ Insert before
作成する波形が Sequence ウ ィ
ン ド ウの指定したセルの前に
挿入されます。 動作モードが
シーケンス以外の場合、 この
パラ メータは無効にな り ます。

■ Create only
新規に波形を作成しますが、
波形はロード されません。
Waveform Name 欄に波形の名
称を入力します。 作成される
波形は Waveform List ウ ィ ン
ド ウのユーザ定義波形リ ス ト
に表示されます。

■ Overwrite
既存の波形データが上書きさ
れます。 このコマンドを選択
する と、 現在ロード されてい
る波形が Target Waveform 
Name ボッ クスに表示されま
す。 波形名称を入力するボッ
クス (Waveform Name) は無効
になり ます。

9. Execute をク リ ッ クする と、 波形
が作成されます。

8
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Cut/Copy/Paste/Delete を使用する (Waveform ウ ィ ン ド ウ )
指定した領域を本機器の内部ク リ ップボードにカッ ト またはコピーできます。 カッ ト またはコピー
したデータは、 グラフ表示、 テーブル表示のどちらのモードでも、 指定した位置にペース トできま
す。 これらの操作を実行する と きは、 通常アイテムと レンジを指定します。

■ カッ ト またはコピーするアイテムは以下から選択できます。

■ All – すべてのアイテムが対象

■ Ch n Analog data

■ Ch n Marker 1/Marker 2 data

■ カッ ト またはコピーするレンジは以下から選択できます。

■ All – すべてのデータをカッ ト またはコピー

■ Between Cursors – 2 つのカーソル間の領域をカッ ト またはコピー

■ Selected （テーブル表示のみ） – マウスをド ラ ッグしてカッ ト またはコピーする領域を選択し

ます。 Cut ダイアログ ・ ボッ クスの Range フ ィールドでは Selected がチェ ッ ク されます。

Cut 操作例

Waveform ウ ィ ン ド ウのグラフ表示でもテーブル表示でもカッ ト操作を実行できます。 以下にグラ
フ表示のと きのカッ ト操作例を示します。

注 ：内部ク リ ップボードは、 本機器のアプ リ ケーシ ョ ン内にあ り、 Windows のク リ ップボード とは

別のものです。 Microsoft Excel 等から本機器のク リ ップボードにデータを転送するこ とはできませ

ん。 他のアプ リ ケーシ ョ ンからのデータ転送では、 インポート / エクスポート機能を使用します。

1. Waveform ウ ィ ン ド ウでカッ トす
るアイテムを指定します。

1
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ヒ ント

■ Delete （削除） は内部ク リ ップボードの内容が変わらないとい う点を除く とカッ ト と同じです。

■ すべてのアイテムがカッ ト または削除される と、 波形長はその分短くな り ます。

2. カーソルを使ってレンジを指定し
ます。

3. Edit > Cut... を選択してダイアロ
グ ・ ボッ クスを表示します。
Waveform ウ ィ ン ド ウ上で右ク
リ ッ ク して表示されるポップアッ
プ ・ メニューから Cut を選択する
こ と もできます。

レンジの設定を変更したいと き
は、 このダイアログ ・ ボッ クスで
変更できます。

4. OK をク リ ッ ク します。

5. カッ トが実行されます。 波形がシ
フ ト し、 後ろの部分はデフォルト
値で埋められます。

注 . 一部のアイテムがカッ ト または
削除されても波形長は短くな り ませ
ん。 データはシフ ト します。 シフ ト
した領域の後の部分は、 デフォル ト
値が入り ます。
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シーケンスの定義

DUT の完全な動作テス ト を行うには、 しばしば長い波形ファ イルを作成する必要があ り ます。 波形
の一部が繰り返される場合、 波形シーケンス機能によって、 大量のメモ リ を消費するプログラ ミ ン
グ作業を大幅に減らすこ とができます。

シーケンスは主に下記の用途で使用されます。

■ ハード ウェアの波形メモ リ よ り も長い波形を出力したいと き

■ 出力信号を高速で切り替えたいと き （ATE アプ リ ケーシ ョ ンなど）

ヒ ント

■ 動作モードで Sequence が指定される と、シーケンス定義に従って波形の出力が行われます。シー
ケンス定義は連続するシーケンス ・ エレ メン トからな り、 各々のシーケンス ・ エレ メ ン トは以下
の情報を持ちます。

■ 各チャンネルの波形への参照

■ シーケンス制御パラ メータ  （Wait Trigger、 Repeat、 Event Jump To および Go To）

1. シーケンスを定義するには、 Edit 
> Sequence Control Parameters...
を選択してダイアログ ・ ボッ クス
を表示します。

2. Wait Trigger がチェ ッ ク される
と、 シーケンサはそのエレ メン ト
の波形を出力する前に ト リガを待
ちます。

3. シーケンスの各エレ メン トで
Repeat カウン トが指定される と、
波形が指定された回数繰り返され
ます。

4. Event Jump To は、 外部イベン ト
によって波形の出力順序を変更し
ます。

サポート されるイベン ト信号につ
いては、 下記のヒン ト を参照。

5. シーケンス ・ エレ メン トに Go To
ターゲッ ト を指定する と、 指定さ
れた波形の出力が終わり次第、
シーケンサは Go To で指定され
たエレ メン トへ制御を移します。

Go To が指定されていない場合は
シーケンサは単純に次のエレ メン
ト を実行します。

1

2

5

4

3

46 AWG7000 シ リーズ ク イ ッ ク ・ ス ター ト ・ ユーザ ・ マニュアル



Edit メ ニューを使用する
■ シーケンスは最初のエレ メン ト （Element Index = 1） から順に実行されます。 ただし Event Jump 
To あるいは Go To の指定がある場合にはそれに従って実行されます。

■ イベン ト と して、 以下の信号がサポート されます。

■ 前面パネルの Event Input コネク タに適用される信号

■ 前面パネルの Force Event ボタンが押された場合

■ リ モー ト ・ コマン ド

注 ：任意波形ゼネレータには、 作成したシーケンスを実行するモード と してハード ウェア ・ シーケ

ンサと ソフ ト ウェア ・ シーケンサの 2 つのモードがあ り ます。 2 つのモードの違いについては、 オ

ンラ イン ・ ヘルプを参照して ください。
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シーケンスの編集

作成したシーケンスを編集するためのコマンドが Edit メニューに用意されています。

Clear. Clear は選択されたデータを初期化します。 複数の非連続なエレ メン ト をク リ アするこ とがで
きます。 シーケンスの残りのデータはシフ ト しません。

Copy、 Paste-Insert および Paste-Replace. 1 つまたは複数の連続したエレ メ ン トに対して コピーや
ペース ト を行う こ とができます。 ク リ ップボードのデータがシーケンスの指定した位置に挿入また
は置き換えられます。 Paste-Insert では、 残りのデータはシフ ト します。

Cut 操作例（ シーケンス・ モード ）

1 つまたは複数の連続したエレ メ ン トに対して Cut や Delete ができます。

ヒ ント

■ シーケンス編集の各種コマンドの詳細については、 オンラ インヘルプを参照して ください。

1. Cutするエレ メン ト を指定します。
右の例では、 Index 番号 2 が対象
になり ます。

注 . Cut および Delete はエレ メン ト
単位でしか行えません。

2. Edit メニューまたはポップアッ
プ ・ メニューから Cut を選択しま
す。

3. Cut が実行され、 残りのデータは
シフ ト します。

注 . Delete ではク リ ップボードの
データは変わり ませんが、 Cut では
カッ ト されたデータがク リ ップボー
ドに入れられます
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Set Waveform/Insert Waveform を使用する

Sequence ウ ィ ン ド ウで波形の置き換えまたは挿入ができます。

■ Set Waveform – 選択した波形を Sequence ウ ィ ンド ウの指定したセルにセッ トするか、 または指
定した波形と置き換えます。

■ Insert Waveform – 選択した波形を Sequence ウ ィ ン ド ウの指定した位置に挿入します。

ヒ ント

■ Waveform List ウ ィ ン ド ウに リ ス ト されている波形を選択して、 直接 Sequence ウ ィ ン ド ウにド
ラ ッグしても、 波形の置き換えまたは挿入が可能です。

1. Sequenceウ ィ ンド ウで波形を置き
換えまたは挿入したいセル上で右
ク リ ッ ク してポップアップ ・ メ
ニューを表示し、 Set Wave-
form... または Insert Waveform...
を選択します。

または、 Edit メニューから も こ
れらの機能にアクセスできます。

2. Waveform List ウ ィ ンド ウに リ ス
ト されている波形の情報が表示さ
れます。 置き換えまたは挿入した
い波形を選択します。

3. OK をク リ ッ クする と波形の置き
換えまたは挿入が実行されます。
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Paste-Insert/Paste-Replace を使用する

Waveform ウ ィ ンド ウまたは Sequence ウ ィ ン ド ウ上でク リ ップ ・ ボードのデータを挿入または置き
換えできます。 以下の例は、 Waveform ウ ィ ン ド ウでの Paste-Insert 操作例です。

ヒ ント

■ Paste-Insert を実行する と、 残りのデータはシフ ト されます。

■ Paste-Replace を実行しても、 残りのデータはシフ ト されません。

1. Ch 2 の波形を選択します。

2. カーソルを使用して、 コピー範囲
を指定します。

3. Edit > Copy... を選択して、 ダイ
アログ ・ ボッ クスを表示し、 アイ
テムとレンジを指定します。

4. OK をク リ ッ ク してコピーを実行
します。

5. Ch 1 の波形を選択します。

6. Paste-Insert する位置を指定しま
す。

7. Edit メニューから Paste-Insert を実
行する と、 Ch 1 の波形にコピー
したデータが挿入されます。
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Rename を使用する

Waveform List ウ ィ ン ド ウに表示される波形の名前を変更できます。

その他の Edit メ ニューを使用する

Scale. Edit メニューの Scale... を使用してアナログ ・ データの指定したレンジについて、 波形の形
状を維持したまま大きさを変えるこ とができます。

1. Waveform List ウ ィ ンド ウで名前
を変更したい波形を選択し、 メ
ニュー ・ バーで Edit > Rename..
を選択する と Rename ダイアロ
グ ・ ボッ クスを表示します。

2. 現在の波形名称が表示されます。

3. 新しい波形名を入力します。

2

3

1

1. 垂直軸スケールの原点 (Origin) と
スケール ・ ファ ク タを設定できま
す。 スケール ・ ファ ク タに単位は
あ り ません。

2. アイテムとレンジについては、
44 ページを参照して ください。

1
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Offset. Edit メニューの Offset... を使用して、 アナログ ・ データの指定したレンジについて、 定数を
加えるこ とができます。

Invert. Edit メニューの Invert... を使用して、 指定したレンジのデータを反転させる こ とができま
す。

1. オフセッ トは、 Voltage または
Normalized Value で設定できま
す。

2. アイテムとレンジについては、
44 ページを参照して ください。

1. アイテムとレンジについては、
44 ページを参照して ください。

アナログ ・ データでは、 プラスの
値がマイナスにな り ます。 マー
カ ・ データでは、 ロー (0) がハイ
(1) にな り ます。
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Horizontal Shift/Rotate. Edit メニューの Shift/Rotate... を使用して、 指定したレンジの波形データを
水平方向にシフ ト または回転するこ とができます。

ヒ ント

■ Horizontal Rotate は、 波形が繰り返し出力される場合に、 ある波形の最後の部分と次の波形の冒
頭部分が滑らかにつながっているかど うかを確認するために使用されます。

■ Horizontal Shift/Rotate はアナログ ・ データおよびマーカに適用されます。

Set High/Low. Edit > Marker/Digital メニューの Set High/Low... を使用して、 指定したレンジのマー
カ ・ データをハイまたはローに設定するこ とができます。

1. モード （Shift または Rotate） を選
択します。

Shift または Rotate の値 （Time ま
たは Points） を設定できます。

2. LinearまたはQuadraticの補間方法
を選択します。

3. アイテムとレンジについては、
44 ページを参照して ください。

1. High または Low を選択します。

2. アイテムとレンジについては、
44 ページを参照して ください。
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PRBS. 波形の指定したレンジの PRBS パターンを置き換えるこ とができます。

Set Pattern. マーカ ・ データの指定した領域をデジタル ・ パターンで埋めるこ とができます。

1. PRBS パターンを選択します。

2. Mark Density を選択します。

3. 反転オン / オフを指定できます。

4. アイテムとレンジについては、
44 ページを参照して ください。

1. パターンを直接入力するか、 また
はテキス ト ・ ファ イルから読み込
むこ と もできます。

指定できるパターンの最大長は
1000 です。

2. アイテムとレンジについては、
44 ページを参照して ください。

複数のアイテムが Set Pattern の
ターゲッ ト と して指定された場合
は、 すべてのアイテムに同じデー
タが埋め込まれます。
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Clock Pattern. マーカ ・ データの指定した領域を 1010 のク ロ ッ ク ・ パターンで埋めるこ とができま
す。

Binary Counter. マーカ ・ データの指定した領域をバイナリ ・ カウンタ ・ パターンで埋めるこ とがで
きます。

1. アイテムとレンジを変更したいと
きは、 このダイアログ ・ ボッ クス
で変更できます。

1. パターンの方向 （Up counter また
は Down counter） を指定します。

Up counter は all 0 から始ま り、
Down counter は all 1 から始ま り
ます。

2. アイテムとレンジについては、
44 ページを参照して ください。
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Waveform Properties. Waveform Properties ダイアログ ・ ボッ クスを使用して、 波形データのプロパ
ティ を参照した り、 変更するこ とができます。

1. Waveform List ウ ィ ンド ウの波形
リ ス トから波形を選択し、 メ
ニュー・バーの Edit > Waveform 
Properties... を選択する とダイア
ログ ・ ボッ クスが表示されます。

または、 Waveform ウ ィ ン ド ウや
Settings ウ ィ ン ド ウの Ch ページ
で右ク リ ッ ク して表示されるポッ
プアップ ・ メニューから もアクセ
ス可能です。

2. 波形長を確認 / 変更できます。

3. 波形データのフォーマッ ト （Real
または Integer） を確認 / 変更でき
ます。
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View メ ニューを使用する
View メニューを使用して任意波形ゼネレータのスク リーン表示をコン ト ロールします。

1. Go To... ダイアログ ・ ボッ クスを
開きます。

2. ズーム機能のコマンドです。
61 ページ参照。

3. スク リーンに表示されるコン ト
ロール ・ ウ ィ ン ド ウやステータ
ス ・ バーの表示 / 非表示を選択し
ます。

4. Display Properties ダイアログ ・
ボッ クスを開きます。

5. リモート ・ コマンド ・ バー
（18 ページ参照） の表示 / 非表示
を選択します。
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Go To ダイアログ ・ ボ ッ ク スを使用する

Sequence ウ ィ ン ド ウや Waveform ウ ィ ン ド ウで、 Index 番号や波形のポイン ト数を指定して、 ウ ィ
ン ド ウの表示ポイン ト をすばやく移動できます。

ヒ ント

■ Waveform List ウ ィ ン ド ウで Go To ダイアログ ・ ボッ クスを使用するこ と もできます。

1. Sequence ウ ィ ンド ウで、 View > 
Go To... を選択する と、 右のよ う
な Go To ダイアログ ・ ボッ クス
が表示されます。

Go To のターゲッ ト （移動先） を
指定するか、 または Value フ ィー
ルドにインデッ クス番号を入力し
ます。

Sequence ウ ィ ンド ウの場合 Go 
To のターゲッ ト と して時間を指
定するこ とはできません。

2. OK をク リ ッ クする と、 表示が指
定された位置に切り替わり ます。

3. Waveform ウ ィ ン ド ウで、 View > 
Go To... を選択する と、 右のよ う
な Go To ダイアログ ・ ボッ クス
が表示されます。

Go To のターゲッ ト （移動先） を
指定するか、 または Value フ ィー
ルドに Points または Time の値を
入力します。

4. OK をク リ ッ クする と、 表示が指
定された位置に切り替わり ます。

1

2

3

4
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View メ ニューを使用する
Display Properties ダイアログ ・ ボ ッ ク スを使用する

任意波形ゼネレータの波形編集およびシーケンス編集用の各ウ ィ ンド ウの表示方法を設定できます。

1. View メニューから Display 
Properties... を選択する と、 Dis-
play Properties ダイアログ ・ ボッ
クスが表示されます。

Waveform Window タブをク リ ッ
ク します。

2. Waveform ウ ィ ン ド ウの表示
フォーマッ ト と して Graphic また
は Table を選択できます。

3. Graphic表示でOverlayを選択する
と、 複数のチャンネルのアナロ
グ ・ データが重なって表示されま
す。

4. Graphic 表示の場合、Grid のオン /
オフを選択できます。

5. Table を選択する と、 表示方法を
次の中から選択できます。

■ Binary

■ Hex

■ Voltage

■ Normalized

6. Waveform ウ ィ ン ド ウに表示され
るアイテムを選択します。

7. 垂直軸の単位を選択します。

8. 水平軸の単位を選択します。

垂直軸と水平軸の単位設定はすべ
てのチャンネルに共通です。

8

7

1

3
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2

4

5
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View メ ニューを使用する
ヒ ント

■ DAC 分解能が 10 bits に設定される と、マーカは表示されません。DAC 分解能の設定については、
26 ページを参照して ください。

9. Sequence Window タブをク リ ッ ク
します。

10. Sequenceウ ィ ンド ウの表示フォー
マッ ト と して Graphic または
Table を選択できます。 表示はす
べてのチャンネルに共通です。

11. Graphic を選択する と、 表示方法
（Thumbnail または Waveform 
Name） を選択できます。

11

10
9
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View メ ニューを使用する
ズームを使用する

ズーム機能を使用する と、 波形表示を拡大または縮小できます。

1. Zoom In
水平方向と垂直方向に波形データ
が拡大されます。

2. Horizontal Zoom In
波形データが水平方向に拡大され
ます。

3. Vertical Zoom In
波形データが垂直方向に拡大され
ます。

ズーム時の垂直軸のスケール定義
については、 Preferences ダイア
ログ ・ ボッ クスで設定できます。
69 ページ参照。

4. Zoom Out
直前のズーム ・ イン操作の前の状
態に戻り ます。 Zoom Out は、 波
形を拡大したあとにのみ使用可能
です。

5. Fit to Window
波形データがウ ィンド ウ ・ サイズ
に調整され、 最初のズームの前の
状態に戻り ます。 この機能は、 波
形を拡大したあとにのみ使用可能
です。

2

4

3

1

5
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Settings メ ニューを使用する
Settings メ ニューを使用する
Settings メニューから Settings ウ ィ ン ド ウの表示項目のコン ト ロールができます。

ヒ ント

■ Waveform Rotation は、 各チャンネル独立して設定できます。

■ Analog Phase – 度 （° 、 degree） で指定します。

■ Analog Delay – 時間またはポイン ト で指定します。

■ Waveform Rotation の設定を行っても Waveform ウ ィ ン ド ウの波形表示には影響しません。

1. Settings ウ ィ ン ド ウの対応する
ページがアクティブにな り ます。

2. アナログの振幅設定とマーカ設定
は、 Amplitude/Offset と
High/Low の組み合わせを任意に
選択できます。

3. Waveform Rotation の設定単位を
選択します。 パラ メータ値は
Settings ウ ィ ン ド ウの Ch n ページ
で入力します。

4. Coupling ダイアログ ・ ボッ クス
を開きます。

5. Analog (Marker) Amplitude/Offset
を選択する と、 Settings ウ ィ ンド
ウの Ch ページのパラ メータ表示
が Amplitude、 Offset とな り ま
す。

6. Analog (Marker) High/Low を選択
する と、 Settings ウ ィ ン ド ウの
Ch ページのパラ メータ表示が
Analog (Marker) High、 Analog 
(Marker) Low とな り ます。

1

2 3

4
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6
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Settings メ ニューを使用する
チャ ンネル結合

複数のチャンネルのパラ メータ設定を一度に変更できます。 この機能をチャンネル結合 (Channel 
Coupling) と呼びます。

1. Settings > Coupling...を選択して、
Coupling ダイアログ ・ ボッ クス
を開きます。

または、 Settings ウ ィ ン ド ウの
Channel ページで右ク リ ッ ク して
も このダイアログ ・ ボッ クスを開
く こ とができます。

2. Ch 1 –> Ch 2 を選択して OK をク
リ ッ ク します。

Ch 1 –> Ch 2 は、 Ch 1 と Ch 2 が
結合されるこ とを意味します。

下記のパラ メータは、 チャンネル
結合の対象から除外されます。

■ チャンネル ・ スキュー

■ 出力波形

■ シーケンス波形

■ Waveform Rotation 機能

■ マーカ ・ ディ レイ

■ 出力信号に関係のないパラ
メータ、 たとえばマーカ表示
のオン / オフなど

1

2

注 ：ご使用の機器が 1 チャンネル ・ モデルの場合、 チャンネル結合の機能は使用できません。
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Tools メ ニューを使用する
Tools メ ニューを使用する
Tools メニューを使用して演算波形の各種設定やアナログ波形のノーマラ イズのオプシ ョ ン設定を
行います。

演算波形

Math ダイアログ ・ ボッ クスを使用して、 編集波形に対して演算を実行できます。 2 つのアナログ波
形データを加算、 減算、 乗算できます。 作成した波形データは Waveform List に追加できます。

ヒ ント

■ 演算結果によ り新規の波形が作成されます。 マーカのデータは第 1 オペランドのものが引き継が
れます。

■ 波形演算はアナログ ・ データの波形全体に対して実行されます。

■ 2 つの波形の長さが等し くない場合は、 演算結果によ り生成される波形の長さは短い方の波形と
同じにな り ます。 長い方の波形の初めの部分が計算に使われます。

1. Tools > Math... を選択する と、
Math ダイアログ ・ ボッ クスが表
示されます。

2. New Waveform フ ィールドに波形
の名称を入力します。

3. 波形リ ス トから波形を選択しま
す。 アイコンをク リ ッ クする と、
Waveform List ダイアログ ・ ボッ
クスが表示されます。

4. 演算子を選択します。

5. 分解能を指定します。

6. Update Image をチェ ッ クする と、
演算結果が Preview に反映されま
す。

7. OK をク リ ッ クする と、 新しい波
形が Waveform List ウ ィ ンド ウに
追加されます。

1

2 3 4
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6
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Tools メ ニューを使用する
ノ ーマ ラ イズ ・ オプシ ョ ン

アナログ ・ データを ノーマラ イズする と きに、 Tools メニューでノーマラ イズのオプシ ョ ン指定を
行います。 ノーマライズは、 波形のアナログ ・ データ全体に対して行われます。

Tools メニューから ノーマライズの
オプシ ョ ンを指定します。

1. Fit to DAC Range, Preserve 
Offset
0 を基準と してスケーリ ングされ
ます。

2. Fit to Full DAC Range
元のデータの最小値が -1.0、 最大
値が +1.0 になるよ うにスケーリ
ングされます。

2

1
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System メ ニューを使用する
System メ ニューを使用する
System メニューを使用する と、 信号発生のコン ト ロール、 機器の校正や診断、 および電源投入時の
機器設定や LCD 輝度調整などのユーザ ・ プ リ ファレンスを設定できます。

ヒ ント

■ System メニューで Run を選択するのは、 前面パネルの Run ボタンを押す、 またはステータス ・
バーの Run ボタンをク リ ッ クするこ と と同じです。

チャ ンネル ・ スキュー調整

チャンネル ・ スキューとは、 各チャンネルのスキュー （遅延） を調整する機能です。

1. RunまたはStopを選択する と信号
発生のコン ト ロールを行います。
Run ステートについては 17 ペー
ジを参照して ください。

2. 対応するダイアログ ・ ボッ クスを
表示します。

1

2

System > Channel Skew... を選択す
る と、 ダイアログ ・ ボッ クスが表示
されます。

1. 各チャンネルのスキューをそれぞ
れ独立して調整できます。 この設
定は、 アナログ出力およびマーカ
出力の両方に適用されます。

2. スキューの値を調整する と、 ダイ
アログ ・ ボッ クスの表示が更新さ
れます。

注 ：ご使用の機器が 1 チャンネル ・ モデルの場合、 チャンネル ・ スキューの機能は使用できません。

1

2
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System メ ニューを使用する
Force Jump To ダイアログ ・ ボ ッ ク スを使用する

Force Jump とは、 シーケンス ・ モードで特定の位置を指定してジャンプさせる機能です。

ヒ ント

■ 任意波形ゼネレータは、Force Jump とは別に Event Jump の機能も持っています。Event Jump は、
シーケンスを外部からのイベン ト信号で切り替える機能です。 Event Jump のパラ メータの設定
は、 Settings ウ ィ ン ド ウの Event ページを使用します。 Event ページについては、 31 ページを参
照して ください。

■ Event Jump のジャンプ先 (Jump Target) の指定は、Edit メニューの Sequence Control Parameters ダ
イアログ ・ ボッ クスを使用します。 46 ページを参照して ください。

■ Force Jump は、 Event Jump に似ていますが、 ジャンプ先が Force Jump To ダイアログ ・ ボッ クス
を使用してユーザによって指定されます。

■ Force Jump は、Event Jump の指定とは無関係です。Event Jump の指定に関係な く Force Jump を実
行できます。

1. System > Force Jump To... を選択
する と、 Force Jump To ダイアロ
グ ・ ボッ クスが表示されます。

2. Target でジャンプ ・ ターゲッ ト を
指定するか、 Index No を選択し
ます。

3. Index No を選択した場合は、
Value: にジャンプ先のインデッ ク
ス番号を入力します。

4. Jump Now をク リ ッ クする と、 波
形出力がジャンプ ・ ターゲッ トで
指定した位置に切り替わり ます。

5. Close をク リ ッ クする と、 ダイア
ログ ・ ボッ クスが閉じます。

1

2
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System メ ニューを使用する
GPIB/LAN の設定

ヒ ント

■ 以下の操作はリモート ・ コン ト ロールからは実行できません。

■ 波形編集

■ 波形のサイズ、 名前の変更

■ 波形のフォーマッ ト変換

■ AWG5000 シ リーズおよび AWG7000 シ リーズ設定ファ イル （*.AWG） からの波形データのイ

ンポート

■ Tektronix DTG5000 シ リーズ ファ イル (*.DTG) のインポート

■ Tektronix AWG400/500/600/700 シ リーズ SEQ ファ イルのインポート

■ ファ イルのエクスポート

System > GPIB/LAN Configuration...
を選択する と、 ダイアログ ・ ボッ ク
スが表示されます。

1. 機器の GPIB バス ・ コ ミ ュニケー
シ ョ ンを設定します。

■ Talk/Listen – 外部ホス ト ・ コ
ンピュータから機器を リモー
ト ・ コン ト ロールします。

■ Off Bus – 機器とGPIBバス間が
切断されます。

2. 本機器は、 次の LAN 接続をサ
ポート します。

■ VXI-11

■ Raw Socket

1

2
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System メ ニューを使用する
ス ク リ ーン表示のユーザ設定

System > Preferences... を選択する
と、 ダイアログ ・ ボッ クスが表示さ
れます。

1. Startup – 電源投入時に呼び出され
る設定を選択できます。 32 ペー
ジ参照。

2. LCD Brightness – LCD の輝度を設
定します。

3. Remote Command Log – 本機器で
使用される GPIB コマンドのシー
ケンスを記録しておく こ とができ
ます。

4. Fit to Window Based On – ズーム・
フ ィ ッ ト時の垂直軸スケール設定
を選択します。

■ H/W Output Range
垂直軸のスケールが機器の出
力可能範囲によ り決ま り ます。

■ Waveform Data
波形データをも とに垂直軸の
スケールが決ま り ます。

5. Hold – シーケンス ・ モード以外
で、 有効な波形長が変更されたと
き、 次のどちらのパラ メータを保
持するかを指定します。

■ Sampling Rate

■ Repetition Rate

6. User Online Help Language – ユー
ザ ・ オンラ イン ・ ヘルプで表示さ
れる言語を選択します。

3

2

1
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5

6
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System メ ニューを使用する
オプシ ョ ンのイ ンス ト ール

Option Installation ダイアログ ・ ボッ クスを使用して、 Tektronix から購入した機器のオプシ ョ ンを
イネーブルにできます。

1. System > Option Installation... を
選択する と、 ダイアログ ・ ボッ ク
スが表示されます。

2. Continue をク リ ッ クする と、 2 つ
目のダイアログ ・ ボッ クスが表示
されます。

Tektronix から提供されるオプ
シ ョ ン ・ インス ト レーシ ョ ン ・
キーを入力して、 スク リーンに表
示される指示に従い、 オプシ ョ ン
をインス トールします。

注 ：オプシ ョ ン ・ キー入力後、 実際にオプシ ョ ンを使用可能な状態にするには、 アプ リ ケーシ ョ ン

を再起動する必要があ り ます。

2

1
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操作例
操作例
こ こでは、 機器を使用して一般的な任意波形ゼネレータの作業を実行する方法を示します。 以下の
例では、 2 チャンネル ・ モデルを使用します。

標準波形の作成と編集

1. 機器の設定をデフォルトにしま
す。

2. Run Mode で Continuous を選択し
ます。

3. Standard Waveform ダイアログ ・
ボッ クスを使用して、 下記のよ う
な方形波を作成します。

■ Waveform Length: 960 points

■ Cycle: 5

■ Amplitude: 1.0 Vp-p

■ Offset: 0.5 V

4. ステップ 3 で作成した波形を Ch 1
にセッ ト します。

5. 波形にCh1-Squareとい う名称をつ
けます。

6. Standard Waveform ダイアログ ・
ボッ クスを使用して、 下記のよ う
なサイン波を作成します。

■ Waveform Length: 1024 points

■ Cycle: 3

■ Amplitude: 1.0 Vp-p

■ Offset: –0.5 V

1

2

3

4

5

6
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操作例
7. ステップ 6 で作成した波形を Ch 2
にセッ ト します。

8. 波形にCh2-Sine とい う名称をつけ
ます。

9. アナログ波形の編集を行う ため
に、 Display Properties ダイアロ
グ ・ ボッ クスを使用して Ch 1 と
Ch 2 のマーカ ・ データを非表示
にします。

10. Ch 1の波形と同じ長さにするため
に、 Ch 2 の波形の後部をカッ ト
します。

カーソルを使用してレンジを設定
します。

11. カッ ト を実行する と、Ch 1 と Ch 2
の波形長が同じにな り、 信号の出
力が可能になり ます。

12. 設定を保存します。

7

8

9

10

11
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操作例
シーケンス編集

1. 機器の設定をデフォルトにしま
す。

2. Run Mode で Sequence を選択しま
す。

3. Waveform List ウ ィ ンド ウの Pre-
defined ページから *Sine960 の波
形を選択して Ch 1 のシーケンス
の 1 番目のセルにセッ ト します。

シーケンスに既存の波形を適用す
る方法については、 24 ページの
ヒン ト を参照して ください。

4. 同様に、 *Triangle960 の波形を選
択して Ch 1 のシーケンスの 2 番
目のセルにセッ ト します。

5. 新規に下記のよ う なサイン波を作
成して、 Ch 1 のシーケンスの 3
番目のセルにセッ ト します。

■ Waveform Length: 960 points

■ Cycle: 5

■ Amplitude: 1.0 Vp-p

■ Offset: 0.0 V

■ 波形名 : Sine-1

6. Sequenceウ ィ ンド ウで最初のエレ
メン ト を選択します。 選択された
セルの背景色が変わり ます。

1
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操作例
7. Sequence Control Parameters ダイ
アログ ・ ボッ クスを使用して、
シーケンスの 1 番目を出力する前
に ト リガを待つよ うに Wait Trig-
ger を設定します。

8. シーケンスの 2 番目に指定された
波形が 5 回繰り返して出力するよ
うに Repeat Count を設定します。

9. シーケンスの 3 番目に指定された
波形の出力後、 1 番目の波形に
ジャンプするよ うに Go To を設
定します。

10. Run ボタンを押してシーケンスが
正常に動作するこ とを確認しま
す。 Running 状態で、 ボタンの左
側のアニメーシ ョ ンが動作しま
す。

右図は、 Sequence ウ ィ ンド ウで
テーブル表示を選択した場合で
す。

7

8

9

10
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